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AIMS AND OBJECTIVES OF THE COURSE  

The aims and objectives of this course include the following:  

1. to understand fundamentally the general scope of the computer system  

2. to interact effectively with the computer  

3. to know the uses of the basic components of the computer  

4. to manage the system to some extent before involving an expert 5.  to know some basic things 

about the computer and the world  

INTRODUCTION  

Computer as a revolution left no area of life untouched in the present world. It is of tremendous help in all 

field of life. Hence, the knowledge of computer is a necessity for existence of everybody in this global village. The 

invention of computer has transformed our simple manual works to sophisticated life of automated works to meet 

the global demand for the higher productivity and increased efficiency with high precision.  

Computer is increasingly becoming compulsory in nearly all fields of studies, not because of anything but 

its accuracy and versatility in processing data. Many tasks at home or office are being automated rapidly with 

computer. Thus it is becoming apparent that in whatever discipline or working sector, the computer is now a very 

vital tool for efficiency improvement and precision of job or task execution.    

This is designed to meet the prerequisite need of everybody that are interested and wish to know about 

computers science and computing in general.  

A computer is an electronic device, operating under the control of instructions stored in its own memory. 

These instructions tell the machine what to do. The computer is capable of accepting data (input), processing data 

arithmetically and logically, producing output from the processing, and storing the results for future use. Most 

computers that sit on a desktop are called Personal Computers (PCs).  

The "computer" is an ensemble of different machines that you will be using to get your job done. A 

computer is primarily made of the Central Processing Unit (usually referred to as the computer), the monitor, the 

keyboard, and the mouse. Other pieces of hardware are commonly referred to as peripherals.  

In everyday life activities, we process data or encounter cases of data processing. A typical example of data 

processing is the generation of statement of student result from the marks score in an examination and continuous 

assessment. It is essential to know that information is as good as the data from which it is derived, and the 

transformation process which they are subjected to. Meaningless data or inappropriate processing produces wrong 

information. Thus computer gives you results corresponding to what data you supply and how you process it (i.e. 

gabbage- in, gabbage-out ).  

Summarily, the intelligent performance of a computer depends on correctness of input data and the  

intelligence performance of the human being that drives it.  
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USES OF COMPUTERS  

People use computers in many ways; business, computers are used to track inventories with bar codes and 

scanners, check the credit status of customers, and transfer funds electronically, homes, tiny computers embedded 

in the electronic circuitry of most appliances control the indoor temperature, operate home security systems, tell 

the time, and turn video cassette recorders (VCRs) on and off, automobiles regulate the flow of fuel, thereby 

increasing gas mileage, they also entertain, creating digitized sound on stereo systems or computer-animated 

features from a digitally encoded laser disc.   

Computer programs, or applications, exist to aid every level of education, from programs that teach simple 

addition or sentence construction to programs that teach advanced calculus. Educators use computers to track 

grades and communicate with students; with computer-controlled projection units, they can add graphics, sound, 

and animation to their communications. Computers are used extensively in scientific research to solve 

mathematical problems, investigate complicated data, or model systems that are too costly or impractical to build, 

such as testing the air flow around the next generation of aircraft. The military employs computers in sophisticated 

communications to encode and unscramble messages, and to keep track of personnel and supplies.  

HISTORY OF COMPUTING  

Since the creation of man, a significant amount of human activities has been ascribed to organizing and 

processing information so that it could be more easily presented for easy comprehension. Many devices have been 

used in the past before the advert of computer. It is then necessary to vividly look into their evolution. Early 

computing machines:  

1. Abacus (-2500BC): This is a hand- held device made of beads stung on rods in a frame. The rods 

correspond to positions of the digits while the beads correspond to the digits.  

2. Napier s Bone (2500BC): This was invented by John Napier s (1550 - 1617). This consists of small 

rods with appropriate markings on them. It is a mechanical aid to computation that consists of nine such rods 

(called bones) with one for each digit 1 through 9. He also invented logarithms which made possible to do division 

and multiplication by performing addition and subtraction.  

3. Slide Rule (1600AD) by William Oughtred (1575 - 660): He invented it in 1622 but announced it in 

1632 this consist of rules on which markings represent logarithms of  numbers and also permits calculation 

involving exponents, trigonometric functions, etc.  

4. Pascal mechanical calculator (1600) or Numerical wheel calculator:-Blaise Pascal (1623 -1664) in 

1642 invented the first adding machine called Pascaline. The brass rectangular box used eight moveable dials to 

add and sum up of eight figures long using base 10. It can perform all the four arithmetic operation with previous 

unheard speed.  

5. Leibnitz mechanical multiplier (1600): In 1694 Gottfried Wilhem Von Leibnitz (1646 -1716) improved 

upon the pascaline by creating a machine that can also multiply using a system of dials and gear.  

6 Colmar s Calculator (1820) by Charles Xavier Thomas de Colmar: This presented a more practical 

approach to computing.  

7 Punched-Card machine (Jacquard s loom) (1801): Joseph Marie Jacquard.  

8 Mechanical computer: Charles Gabbage (1792-1871) Father of the computer. Difference engine 

powered by steam and large as locomotive the machine has a stored program and could perform calculations and 

print the result automatically. We also have Analytical engine credited to him. 9 Hermann Hollerith (1860-1929)                                
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✓ Hollerith s system punch-card reader machine:-for counting census result in 1890 in US.  

✓ formed tabulating machine company in 1896(TMC)  

✓ Automatic Tabulating Machine (ATM)-1900  

✓ TMC was renamed to International Business Machines Corporation (IBM) in 1924 after series 

of mergers.  

In summary, the history of computing began with an analog machine. In 1623 German scientist Wilhelm 

Schikard invented a machine that could add, and with the aid of logarithm tables, multiply and divide. Since then 

the development has pass through a lot of stages such as the invention of punched cards to program patterns to 

create woven fabrics by Joseph-Marie Jacquard a French inventor in 19th century. Another early mechanical 

computer was the Difference Engine, designed in the early 1820s by British mathematician and scientist Charles 

Babbage. In the 1930s American mathematician Howard Aiken developed the Mark I calculating machine, which 

was built by IBM. This electronic calculating machine used relays and electromagnetic components to replace 

mechanical components.  

To be sincere, the world has left the era of hearing stories about computer. We are now in the world of  

what you can use it for to serve its desired purposes.  

GENERATIONS OF COMPUTERS  

The history of computer development is often referred to in reference to the different generations of 

computing devices. Each generation of computer is characterized by a major technological development that 

fundamentally changed the way computers operate, resulting in increasingly smaller, cheaper, more powerful, 

efficient and reliable devices.   

First Generation - 1940-1956: Vacuum Tubes  

The first computers used vacuum tubes for circuitry and magnetic drums for memory, and were often 

enormous, taking up entire rooms. They were very expensive to operate and in addition to using a great deal of 

electricity, generated a lot of heat, which was often the cause of malfunctions. First generation computers relied 

on machine language to perform operations, and they could only solve one problem at a time. Input was based on 

punched cards and paper tape, and output was displayed on printouts. The UNIVAC and ENIAC computers are 

examples of first-generation computing devices. The UNIVAC was the first commercial computer delivered to a 

business client. It was used in the 1951U.S. Bureau Census.   

Second Generation - 1956-1963: Transistors  

Transistors replaced vacuum tubes and ushered in the second generation of computers. The transistor was 

invented in 1947 but did not see widespread use in computers until the late 50s. The transistor was a vast 

improvement over the vacuum tube, allowing computers to become smaller, faster, cheaper, more energyefficient 

and more reliable than their first-generation predecessors. Second-generation computers still relied on punched 

cards for input and printouts for output. Second-generation computers moved from cryptic binary machine 

language to symbolic, or assembly, languages, which allowed programmers to specify instructions in words. High-

level programming languages were also being developed at this time, such as early versions of COBOL and 

FORTRAN. These were also the first computers that stored their instructions in their memory, which moved from 
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a magnetic drum to magnetic core technology. The first computers of this generation were developed for the atomic 

energy industry.   

Third Generation - 1964-1971: Integrated Circuits  

The development of the integrated circuit was the hallmark of the third generation of computers. Transistors 

were miniaturized and placed on silicon chips, called semiconductors, which drastically increased the speed and 

efficiency of computers. Instead of punched cards and printouts, users interacted with third generation computers 

through keyboards and monitors and interfaced with an operating system, which allowed the device to run many 

different applications at one time with a central program that monitored the memory. Computers for the first time 

became accessible to a mass audience because they were smaller and cheaper than their predecessors.   

Fourth Generation - 1971-Present: Microprocessors  

The microprocessor brought the fourth generation of computers, as thousands of integrated circuits were  

built onto a single silicon chip. What in the first generation filled an entire room could now fit in the palm of the 

hand. In 1981 IBM introduced its first computer for the home user, and in 1984 Apple introduced the Macintosh. 

Microprocessors also moved out of the realm of desktop computers and into many areas of life as more and more 

everyday products began to use microprocessors. As these small computers became more powerful, they could be 

linked together to form networks, which eventually led to the development of the Internet. Fourth generation 

computers also saw the development of GUIs, the mouse and handheld devices.   

Fifth Generation - Present and Beyond: Artificial Intelligence   

Fifth generation computing devices, based on artificial intelligence, are still in development, though there 

are some applications, such as voice recognition, that are being used today. The use of parallel processing and 

superconductors is helping to make artificial intelligence a reality. Quantum computation and molecular and 

nanotechnology will radically change the face of computers in years to come. The goal of fifth-generation 

computing is to develop devices that respond to natural language input and are capable of learning and 

selforganization.  

SOFTWARE AND HARDWARE   

Hardware is the term given to the physical components of a computer: e.g. keyboard, monitor, system box or floppy 

disk drive. Software, on the other hand, is electronic information: files, operating system, graphics, computer 

programs are all example of software. The difference between hardware and software reflects the duality between 

the physical and mental worlds: for example, your brain is hardware, whereas your mind is software.       

Software is the stuff that makes your computer do things for you. The computer without software would 

be like a home entertainment system with no tapes, CD s, or movies - you have the machine, but there s nothing to 

play on it. Software is continually developed. Each time the software maker (Microsoft, Adobe, Corel, etc) 

develops a new version of their software they assign it a version number. Before Microsoft Word 7, there was 

Microsoft Word 6.0.1, and before that Word 6.0. The larger the developments made to the software, the larger the 

version number changes. Usually a large change will result in a whole number upgrade; a small change may result 

in a tenth of a decimal place.  Hardware are those components or physical pieces (things you can touch) that make 

up the computer. The different pieces of the computer s hardware are monitor, speakers, mouse, CDROM, floppy 

drive, hard drive, keyboard, CPU, RAM, Processor, etc. Each piece plays a role in the operation of a computer.  
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DIFFERENT PARTS OF A COMPUTER AND THEIR USES  

The standard computer consists of a monitor, a keyboard, a mouse and the system unit. One can attach 

accessories such as printers and scanners by means of ports. Increasingly in the workplace, computers are 

connected to printers and other computers by means of a network.     

  

Figure 1: Computer System Hardware  

The monitor  

This is the Visual Display Unit (VDU). There are various technologies for the display unit, 

cathode ray tube (CRT) or Liquid Crystal Display (LCD) or electro luminescent screens or the 

projector. The monitor or screen displays your work. Facing it down reduces reflected glare 

from room lights. This reflection may affect your sight. Monitors come in different sizes. The 

(most important) size of the monitor is measured diagonally on the screen (in inches). Based on 

this, the monitors range in sizes of 12", 14", 15", 17", 19", 21", 29", etc. Monitors are also 

characterized by the flatness of their screen. The flatter and the wider screens are usually the better.   

The system box or computer console  

The system box is where all the computations that the computer performs take place. Inside 

are the CPU processor, the motherboard, the hard disk, any network or sound cards, memory 

chips (RAM), printer ports (at the back) and the drive bays for floppy disks, Zip disks or CDs. 

Outside the casings are the power buttons (ON/OFF and Restart) with some additional facilities 

like the casing USB ports, Webcams, etc.  
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The keyboard (Pressing)  

This is the basic input device. It is one of the ways you can tell the computer what to do. It 

consists of the standard typewriter keys as well as a numeric keypad and function keys. You 

can use it to give the computer commands, name folders and files, and type text in word 

processing documents. The keyboard is made of three main categories of keys with  

each used for a different purpose.  

i. Character Keys: These comprise of letters, numbers and the symbols. They are used to insert/display readable 

characters on the screen which is equivalent to the keystroke pressed. Letters a, b, c, d, e, f, g, h, i, j, k, l, m, n, o, 

p, q, r, s, t, v, w, x, y, z  

 Numbers  0, 1, 2, 3, 4, 5, 6, 7, 8, 9  

 Symbols    

Accent  `  Dash/Minus  -  Equal  =  Opening Square 

Bracket  

[  Closing Square 

Bracket  

]  

Backslash  \  Semi-Colon  ;  Single-Quote  '  Pipe  |  Greater than  >  

Less than  <  Comma  ,  Period  .  Forward Slash  /  Question mark  ?  

Tilde  ~  Exclamation Mark  !  At  @  Pound  #  Dollar  $  

Dollar  $  Percent  %  Caret  ^  Ampersand  &  Asterisk  *  

Asterisk  *  Opening Parenthesis  (  Closing 

Parenthesis  

)  Underscore  _  Plus  +  

Opening  

Curly  

Bracket  

{  Closing Curly 

Bracket  

}  Colon  :          

  

ii. Action Keys: These are not used to type anything, instead they cause an action. Escape, Tab, Caps Lock, 

Shift, Control, Alt, Backspace, Enter, Windows, Win Menu, Print Screen, Scroll Lock, Pause Break, Number 

Lock, Insert, Home, Page Up, Delete, End, Page Down, Power, Sleep, Wake up, Up Arrow, Left Arrow, Right 

Arrow, Down Arrow, and Space Bar.   

iii. Application-Dependant Keys: These are called function keys. They are F1, F2, F3, F4, F5, F6, F7, F8, F9, 

F10, F11, and F12. Although the F1 key is usually used to get help while working in Microsoft Windows, the use 

of the other keys varies from one application to another. Eventually, the application you use will give you 

instructions on what to do and how to use the function keys. Key Combinations  

Some keys can be combined to produce uppercase letters or to access the upper symbols of some keys (i.e. the 

Shift and Control keys). Keys are also combined for many other reasons. In some situations, you have to press 

keys simultaneously, which means that you may be expected to press two or more keys at the same time, or almost 

at the same time. In some other situations, you may have to press and release one key, followed by another.  

Shortcuts  

A shortcut is a quick action you ask a program to perform when you press one particular key or a combination of 

keys. Some shortcuts are universal or almost, that is, the computer responds regardless of what application is 

running. Some other shortcuts depend on what you have on your screen. Some shortcuts are already known to the 

computer (as part of the operating system). Most other shortcuts are set by the programmer of the particular 

application you are using. Yet some applications allow you to create your own shortcuts. Some shortcuts are readily 
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obvious and can be seen from the main menu of the application. Some other shortcuts are either part of Microsoft 

Windows (and can be applied in your program) or are not easily displayed, you might have to search the Help 

documentation of the program you are using.  

The Mouse (Clicking and Dragging)  

This is another input device used to move a small white arrow pointer-the Cursor (but the shape will 

change depending on the context in which the mouse is being used) on the screen. By pointing and 

clicking you can carry out commands. The computer may ask you to verify that you are sure to rename 

a file, by clicking on the Ok button. A mouse is primarily made of three parts: the buttons, the handling 

area, and the sensor (rolling object or light). There are either one, two or three mouse  

buttons. By default, a mouse has two buttons: left and right. Most mice nowadays are also equipped with a wheel 

on top of the middle button called the Scroll Button.  

 To use the mouse, the first decision you make is to know which of your two hands you will be using to handle the 

mouse. By default, the mouse is configured to work for the right hand. If you are left-handed, the settings can be 

changed to suit your needs: Start ➔ Control Panel ➔ Double-click Mouse ➔ on the Buttons Tab, Check the 

Switch Primary and Secondary Buttons check box.  

You can also change the cursor from the default Up-Left Pointing to another but you should know that this is best 

determined by the computer as this varies from program to program. To change, click the Pointer s Tab. Also click 

the other tabs to review the different properties.  

Note: The expression "by default" means "if everything is not (yet) changed from the original or normal settings".  

  

Figure 2: Mouse Properties Dialog Box  

The tip of the mouse pointer must be positioned on the item you want to use (Pointing). To select an item, 

point to the item and click once (Selection  Left Clicking). Double-clicking (left button) on an icon invokes a 

command or launches an application. Dragging an item (icon or other object) from one location to another, position 

the mouse pointer on the item, click and hold the mouse buttons (left, right) down, and move the item to the new 

location. Right Clicking (right button) invokes a shortcut (contextual) menu that contains all the actions that are 
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related to the item. Some applications, namely programs used to manipulate text (they are called word processors), 

allow you to triple-click.  

On Windows machines, there is a left and right mouse button. Most time you use the left mouse button (if 

you are right-handed). On some newer Macs, the same feature can be used with their single mouse button by 

holding down the Control key as you click an item on the screen.  

The Peripherals  

All the parts we have reviewed so far are usually required for the computer to function. Some other parts, not 

required, can also be connected to the computer to complement it. A peripheral is an object attached to the 

computer to help it perform some necessary assignments none of the other parts can handle. In most scenarios, 

no peripheral is required but nowadays, it is unusual for a computer not to have any peripheral at all. The most 

used peripherals are the printer, a digital camera, a scanner, a projector, an external drive (such as an external 

CD burner for an old computer), etc.  

Disk Size Conversion Chart (Bits, Bytes, Kilobytes, Megabytes and Gigabytes)     

Bit- Binary digit:-a single elements in the computer memory that can store either 1 or 0  

Word  1Byte, 2Byte or 4Byte depending on the machine. Generally computer word length is giving in bits; hence 

we have 8bit, 18bit or 32bit microprocessor computer.  

Table 1: Computer Storage Devices Unit Conversion  

Unit  Equivalent to  

1Byte  8 Bits  

1kilobyte (kB)  1,024Byte  

1MB  1,024KB = 1,024,000Byte  

1GB  1,024MB = 1,024,000,000Byte  

TYPES OF COMPUTERS  

Analog computer  

These systems were the first type to be produced. It is an electronic machine capable of performing 

arithmetic functions on numbers which are represented by some physical quantities such as temperature, pressure, 

voltage, etc. Analog refers to circuits or numerical values that have a continuous range. Popular analog computer 

used in the 20th century was the slide rule.   

Digital Computers  

Virtually all modern computers are digital. Digital refers to the processes in computers that manipulate 

binary numbers (0s or 1s), which represent switches that are turned on or off by electrical current. A bit can have 

the value 0 or the value 1, but nothing in between 0 and 1. A desk lamp can serve as an example of the difference 

between analog and digital. If the lamp has a simple on/off switch, then the lamp system is digital, because the 

lamp either produces light at a given moment or it does not. If a dimmer replaces the on/off switch, then the lamp 

is digital, because the amount of light can vary continuously from on to off and all intensities in between. Digital 

computers are more common in use and it will be our focus of discussion.  
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Hybrid Computer  

This is when a computer make is of both analog and digital components and techniques. Such computer 

require analog to digital and digital to analog converter which will make analog and digital data palatable to it. The 

basic classification nowadays uses the following.  

1. The Desktop  

  

A computer is referred to as "desktop" when it is relatively small enough to be positioned on top of 

a table where a person is working. Such a computer can also be placed on the floor or somewhere 

under, or aside of, the table, in which case the monitor would be placed on top of the table. This is 

the most common type of computers used in the office or at home. A desktop computer is made of 

different parts that are connected with cables.   

2.   The Laptop  

  

A computer is called laptop when it combines the CPU, the monitor, the keyboard, and the 

mouse in one unit to be so small that you can carry it on your laps when traveling or commuting. A 

laptop is also called a notebook. Other parts, such as an external mouse, an external keyboard, or 

peripherals such as a printer or a projector, can be connected to the laptop. A laptop is only 

physically smaller than a desktop but, everything considered, it can do anything that a desktop can 

do.   3.   The Server  

A server is a computer that holds information that other 

computers, called workstations, can retrieve. Such workstations 

are connected to the server using various means. This means that 

they could be connected using cable, wireless connection, etc. 

Only computers that maintain a type of connection with the server 

can get the information that is stored in the server.   

Normally, although not particularly recommended, any computer, 

including a desktop or even a laptop can be used as a server, as long as it can do the job required. A server is more 

defined by the program (called an operating system) that is installed in it, not how the machine looks.   

Any type of computer, including a desktop, a laptop, a CD or DVD machine, etc can be connected to a server. The 

person who sets up a server also defines the types of connections it is made for.   

4. The Mainframe  

  

A mainframe is a computer, usually physically big, that does almost all the jobs for other types of 

computers that are connected to it. This is a broad definition but other aspects are involved. Like a 

server, the program (operating system) that runs in the mainframe defines its role.   

  

ANATOMY OF COMPUTER SYSTEM  

A typical computer system irrespective of its size, class or type consists of hardware and software,  

integrated and harmonized together to perform computational work (scientific or military) or data processing.  
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COMPUTER HARDWARE  

Hardware system: Computer hardware consists of the components that can be physically handled. It refers 

to the physical units or machine of functional units, which makes up the computer configuration which is done to 

suit the goals and objectives of the user. The function of these components is typically divided into three main 

categories: input, output, and storage. Components in these categories connect to microprocessors, specifically, the 

computer s central processing unit (CPU), the electronic circuitry that provides the computational ability and 

control of the computer, via wires or circuitry called a bus. Hardware may be classified into Central Processing 

Units (CPU) and the peripherals. The CPU entails Control Unit (CU), Arithmetic and Logic Unit (ALU) and the 

Internal Memory Unit (IMU) or main memory. The peripherals consist of the input, output and Auxiliary Storage 

Units.  

Strictly speaking, computer is made up of five district elements to include:  

1. A central processing unit (ALU and CU)  

2. Input unit  

3. Output unit  

4. Storage unit (Internal and Auxiliary)  

5. The communication network; Bus that links all the elements of the system, and connects the   

6. External world. (Cables and Cords)  

MOTHERBOARD: The motherboard is a printed circuit board that connects other components through 

the use of traces, or electrical pathways. The motherboard is indispensable to the computer and provides the main 

computing capability. Personal computers normally have one central processing unit (CPU) on the motherboard.   

THE CENTRAL PROCESSING UNIT (CPU)   

This is the main brain of the computer that accepts data, performs operations on the data and sends out the 

result.Information from an input device or from the computer s memory is communicated via the bus to the  

Central Processing Unit (CPU), which is the part of the computer that translates commands and runs programs.  

It consists of ALU and CU, and a single chip or series of chips that performs arithmetic and logical calculations  

and controls the operations of the other elements of the system.  

Most CPU chips are composed of four functional sections:  

1. ALU: Calculating ability either arithmetical or logical operations.  

2. Registers: Temporary storage areas that hold data, keep tracks of instruction, and hold the location and results 

of these operations.  

3. Control section: Times and regulates the operation of the entire computer system, by using its instruction 

decoder to read patterns of data in a designated register and translate the patterns into activities, such as addition 

or comparison. It also uses its interrupt input to indicate the order in which individual operations uses the CPU 

and regulates the amount of CPU time allotted to each operation.  

4. Internal Bus: Network of communication lines that connects the internal elements of the processor and also 

leads to external connectors that links the processor to the other element of the computer.  

The main functions of the microprocessor (CPU clips) includes the following.  
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a. Control use of the main storage in storing data and instructions (i.e the ROM).  

b. Control the sequence of operations.  

c. Give commands to all parts of the computer system.  

d. Carry out processing.  

INPUT DEVICES  

Input unit consists of external devices that is, components outside the computer s CPU. It provides or 

fetches information and instructions to the computer. These include keyboard, mouse (mechanical/ 

optomechanical/ opticals), light pen, joystick, scanner, microphones (voice recognition modules), Optical 

Character Reader (OCR), Magnetic Ink Character Reader Recognition (MICR), bar code reader, badge reader, 

digitizer, touch screen and optical mark reader (OMR).  

A. Light pen: This is a stylus with a light sensitive tip that is used to draw directly on a computer s video 

screen or to select information on the screen by pressing a clip in the light pen or by pressing the light pen 

against the surface of the screen. The pen contains light sensors that identify which portion of the screen 

it is passed over. It is mostly used with Laptop.  

B. Mouse: This is a pointing device designed to be gripped by one hand. It has a detection device (usually a 

ball) on the bottom that enables the user to control the motion of an on-screen pointer, or cursor, by 

moving the mouse on a flat surface. As the device moves across the surface, the cursor moves across the 

screen. To select items or choose commands on the screen, the user presses a button on the mouse.   

C. Joystick is a pointing device composed of a lever that moves in multiple directions to navigate a cursor 

or other graphical object on a computer screen.  

D. Keyboard: Keyboard is typewriter-like devices that allows the user to type in text, numeric and execute 

commands with the aid of the functional keys on the keyboard.  

E. Optical Scanner: This is light-sensing equipment that converts images such as a picture or text into 

electronic signals that can be manipulated by a computer. For example, a photograph can be scanned into 

a computer and then included in a text document created on that computer. The two most common 

scanner types are the flatbed scanner, which is similar to an office photocopier, and the handheld scanner, 

which is passed manually across the image to be processed.  

F. Microphone: This is a device for converting sound into signals that can then be stored, manipulated, and 

played back by the computer. A voice recognition module is a device that converts spoken words into 

information that the computer can recognize and process.  

G. Modem: It stands for modulator-demodulator, is a device that connects a computer to a telephone line or 

cable television network and allows information to be transmitted to or received from another computer. 

Each computer that sends or receives information must be connected to a modem.   

OUTPUT DEVICES  

Output devices consists of hardware that transfer information from the computer s CPU to the computer 

user. This includes the monitor, Printer, plotters, or speaker.  

Video Graphic Adapter: This is a device that converts information generated by the computer into visual 

information called Monitor. It looks similar to a television set. Information from the CPU is displayed on the 

screen of the monitor.  

Printers: Information and graphics processed or produced with the aid of computer are printed out as hardcopy 

with the aid of printer. There are different types of printers; Dot-matrix printers, Laser printers, Inkjet, etc.  
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Plotters: Computer output to microfilm or fiche (COM) which process information on rolls of film (drum plotter) 

or slide of film (flatbed plotter).  

STORAGE DEVICES  

Storage devices provide permanent storage of information and programs for retrieval by the computer. The 

two main types of storage devices are disk drives and memory. There are several types of disk drives: hard disk 

drive, floppy disk, magneto-optical, and compact disk.  

Hard disk drives store information in magnetic particles embedded in a disk. Usually a permanent part of the 

computer, hard disk drives can store large amounts of information and retrieve that information very quickly. 

The disks are of different sizes such as 1G, 10G, 40G, etc.  

Floppy disk drives also store information in magnetic particles embedded in removable disks. Floppy disks 

store less information than a hard disk drive and retrieve the information at a much slower rate. It is of 2 type 

51/4 floppy disk and 31/2 floppy disk.  

Magneto-optical disc drives store information on removable discs that are sensitive to both laser light and 

magnetic fields. They can typically store as much information as hard disks, but they have slightly slower 

retrieval speeds.  

Compact Disc Drives store information on pits burned into the surface of a disc of reflective material such as 

CD-ROM. CD-ROMs can store about as much information as a hard drive but have a slower rate of information 

retrieval.  

Digital Video Disc (DVD): This is similar and works like a CD-ROM but can store more than 15times as much 

information.  

Flash drives work as floppy disks but more sensitive as a hard disk that must be ejected logical before final removal 

from the computer system. It has more memory than floppy disks.     

Memory Cards work as flash drive but with an additional device called the card reader. This is very effective 

and more durable than the flash drives.  

Some devices serve more than one purpose. For example, floppy disks may also be used as input devices if they 

contain information to be used and processed by the computer user. In addition, they can be used as output devices 

if the user wants to store the results of computations on them.  

SYSTEM MEMORY  

Memory refers to the computer chips that store information for quick retrieval by the CPU. They are 

basically divided into two ROM and RAM.   

Random Access Memory (RAM) is used to store information and instructions that operate the computer 

s programs. Typically, programs are transferred from storage on a disk drive to RAM. RAM is also known as 

volatile memory because the information within the computer chips is lost when power to the computer is turned 

off or the computer hanged.   

Read-Only Memory (ROM) contains critical information and software that must be permanently available 

for computer operation, such as the operating system that directs the computer s actions from start up to shut down. 

ROM is called non-volatile memory because the memory chips do not lose their information when power to the 

computer is turned off.  
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HARDWARE CONNECTIONS   

To function, hardware requires physical connections that allow components to communicate and interact. 

A bus provides a common interconnected system composed of a group of wires or circuitry that coordinates and 

moves information between the internal parts of a computer. A bus is characterized by two features: how much 

information it can manipulate at one time, called the bus width, and how quickly it can transfer these data.  

A serial connection is a wire or set of wires used to transfer information from the CPU to an external device such 

as a mouse, keyboard, modem, scanner, and some types of printers. This type of connection transfers only one 

piece of data at a time, and is therefore slow. The advantage of using a serial connection is that it provides effective 

connections over long distances.  

A parallel connection uses multiple sets of wires to transfer blocks of information simultaneously. Most scanners 

and printers use this type of connection. A parallel connection is much faster than a serial connection, but it is 

limited to distances of less than 3 m (10 ft) between the CPU and the external device.  

COMPUTER SOFTWARE  

Software is the set of instruction that tells the computer what to do and when to do it. The computer uses 

this instruction to manipulate data, and enhance the proper functioning of the hardware components. It is designed 

to exploit and provide the potential capabilities of the hardware to the user. It converts data into information and 

allows users to use the computer in different ways.  

Computer programs are written by human beings, like you. This means that the person who writes a 

program also decides on its functionality and behaviour; which explains why two programs that are supposed to 

do the same thing, don't do it the same way. This is why, regardless of your expertise, you need to be acquainted 

with a particular program in order to make better use of it. The fact that you don't know a particular program doesn't 

say anything about your intelligence or lack of it. It simply means that you are not familiar with that program.  

These programs are usually stored and transferred via the computer s hardware to and from the CPU. 

Software also governs how the hardware is utilized; for example, how information is retrieved from a storage 

device. The interaction between the input and output devices is controlled by software called the Basic Input Output 

System (BIOS) Software. Software as a whole can be divided into a number of categories based on the types of 

work done by programs. The two primary software categories are system software, and application  

software.  

SYSTEM SOFTWARE  

This refers to set of programs that facilitate the optional use of the hardware systems by coordinating them. 

It consists of programs that start up the computer and perform some utility functions such as checking and getting 

the computer ready for use. They are usually written to accomplish loading, execution, storage, and retrieval of 

files from/into the computer. They are basically operating system, utility software, and language translators.   
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Operating System  

An operating system is a program that acts as an intermediary between the application programs and the 

computer hardware.You cannot directly use computer applications (or programs) with computer hardware without 

a translation system between the hardware and the applications. This translation system is called the operating 

system (OS). The Windows or Mac OS works behind-the-scenes to run your computer (i.e. the software and the 

hardware). It tells the computer what to do when it starts up and keeps track of your documents, files, and other 

software. It also provides the standard user interface component (like menus and the desktop) that you see when 

you look at your computer screen. Both the Windows and the Mac OS operating systems use a graphical interface 

(pictures or icons instead of text) that allow you to immerse yourself in multitasking (accessing multiple 

applications and files simultaneously). You work with windows in this interface. These windows are a series of 

boxes, which can be opened and closed as needed.  

We shall be using Microsoft Windows Operating System as it is the most common on the personal 

computers. There are various types of Microsoft Windows. A type of Microsoft Windows is referred to as a version. 

Examples of versions are Microsoft Windows 3.3, Microsoft Windows 95, Microsoft Windows NT Workstation, 

Microsoft Windows NT Server, Microsoft Windows 98, Microsoft Windows 98 Second Edition,  

Microsoft Windows Millennium, Microsoft Windows 2000 Professional, Microsoft Windows 2000 Server, 

Microsoft Windows XP Home Edition, Microsoft Windows XP Professional, and Microsoft Windows Server 

2003.  

Operating System Components  

Process management  

Memory management  

File management  

Networking  

System Protection   

Command-interpreter system  

Secondary storage management  

The Operating System Layer  

  

Figure 3: Operating System Layers  

Operating System is the basic software that controls the major operation of the computer. It is the master control 

program, permanently stored in memory, which interprets users commands requesting various kinds of services  



Computer Training  Expert Solution Consults  Computer Basics  

15/59, Nov - 2010    Learn to Know Why and How!   adebisijeleel@yahoo.com or 

adebisijeleel@gmail.com  

      

such as display, print or copy a data files; list all files in a directory; or execute a particular program. It provides the 

link between the user, the application program and the computer hardware with a view to controlling and managing 

the operation of the computer. The operating system has four major functions: It coordinates and manipulates 

computer hardware, it organizes and manages files on a variety of storage media, it manages the function of 

processor, and it interfaces with user.  

Function of the OS  

• Resource sharing: manages resources by ensuring proper and effective use.  

• Provision of virtual machine: Hidings the hardware details from the user.  

• Memory management: It manages the effective usage of internal memory, RAM while running multiprograms.  

• Protector and error handling.  File management.  

• Facilitates booting  

• Manages multitasking: determines which application should run, in what order, and how much time should be 

allowed for each application before giving another application access to run.  

Classification of OS  

This could be done based on the number of program they can handle at the same time or the number of 

user(s) that can be accommodated on the system simultaneously. Hence we have single tasking and multitasking 

(for class1) and, single user and multi-user OS (for class 2).  

Single user OS is multitasking but can only allow only one user at a time e.g. PC-DOS, MS-DOS, CP/M, OS/2. 

Multi-user OS is multitasking and at the same time multi-user. This is done when a number of computers 

(workstation) connect to a central computer so that all the other computers can use the work on the central computer 

e.g. UNIX, XENIX, PC-MOS, windows NT, Linux and Novell.  

The Difference between Windows &Macs  

The personal computer industry has generally sorted itself out along the lines of two major operating 

systems: Mac and Windows. The Mac OS runs on CPUs made by Apple Computer. The Windows OS, made by 

Microsoft, runs on CPUs made by many different companies, but not Apple. Some of these companies are: IBM, 

Dell, Compaq, Gateway, Fujitsu, Sony, etc. When people talk about the differences between Windows and Macs, 

in general, they are expressing a personal preference about which operating system or hardware they believe to be 

superior.  

Utility Software  

This program is produced by the manufacturers to provide useful facilities for performing common computing tasks 

of a routine nature to many computer system e.g. system generator, text editor, antivirus, dumping routine, 

housekeeping operations etc.  

Language translator  

The language the computer understand is machine language (Os and 1s) which is very tedious, time consuming, 

hard to write/read, or debug. Any program written in another language than this needs language translator which 
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carries out the translation to this machine language. The 3 main types of translators are Assemblers, Compilers and 

Interpreter.  

APPLICATION SOFTWARE  

Application Software is a computer program designed to help people perform a certain type of task. An 

application thus differs from an operating system (which runs a computer), a utility (which performs maintenance 

or general-purpose tasks), or a language translator (with which computer programs are created). Depending on the 

work for which it was designed, an application can manipulate text, numbers, graphics, or a combination of these 

elements. Some application packages offer considerable computing power by focusing on a single task, such as 

word processing, spreadsheet, graphics, and a database program.   

Table 2: Different computer programs with their areas of application  

Application Areas  Package  

Word processing  NotePad (text editor), WordPad, Word perfect, WordStar, Microsoft word  

Budgeting, accounting  Lotus 1-2-3, Microsoft excel,  

Databases   Database 3,4 oracle, Microsoft excel, Corel Paradox, dBase, SQL, M-Access  

Graphics  CorelDraw, Adobe Photoshop, Jasc Paint Shop Pro, Instant Artist, Print Artist  

Spreadsheets  Microsoft Excel and Access, Corel Quattro Pro, Sun StarCalc  

Book publishing  PageMaker, Microsoft publisher   

Seminar presentation  PowerPoint   

Engineering drawing  AutoCAD, ArchiCAD, electronic desktop   

Statistical analysis  SPSS, SPLUS, statistical  

Web design  Microsoft FrontPage  

CLASSIFICATION OF COMPUTERS ACCORDING TO SIZE  

Computers exist in a wide range of sizes and power. The smallest are embedded within the circuitry of 

appliances, such as televisions and wristwatches. These computers are typically pre-programmed for a specific task, 

such as tuning to a particular television frequency, delivering doses of medicine, or keeping accurate time. They 

generally are hard-wired that is, their programs are represented as circuits that cannot be reprogrammed.  

Mini Computers (Laptop, Notebook Computers and Desktop PCs) are typically used in businesses and at 

home to communicate on computer networks, for word processing, to track finances, and for entertainment. They 

are equipped with a keyboard; a mouse, trackball, or other devices; and a video display monitor or liquid crystal 

display (LCD) to display information. Laptop and notebook computers usually have similar hardware and software 

as PCs, but they are more compact and have flat, lightweight LCDs instead of television-like video display monitors. 

If equipped with a cellular phone, they can connect to worldwide computer networks to exchange information 

regardless of location.   

Workstations are similar to personal computers but have greater memory and more extensive mathematical 

abilities, and they are connected to other workstations or personal computers to exchange data. They are typically 

found in scientific, industrial, and business environments especially financial ones, such as stock exchanges that 

require complex and fast computations.  
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Mainframe computers have more memory, speed, and capabilities than workstations and are usually 

shared by multiple users through a series of interconnected computers. The most powerful mainframe computers, 

called supercomputers, control businesses, industrial works, scientific research and process complex and time-

consuming calculations, such as those used to create weather predictions. Large businesses, scientific institutions, 

and the military use them. Some supercomputers have many sets of CPUs. These computers break a task into small 

pieces, and each CPU processes a portion of the task to increase overall speed and efficiency. Such computers are 

called parallel processors. As computers have increased in sophistication, the boundaries between the various types 

have become less rigid.   

COMPUTER VIRUSES AND SECURITY  

COMPUTER VIRUSES  

Virus is a self-duplicating computer program that interferes with a computer s hardware or operating system. 

They range from being merely irritating (or disturbing) to the very destructive. Computer viruses activate when the 

instructions (payload of the virus) or executable code that run programs are opened. Once a virus is active, it may 

replicate by various means and infect the computer s files or the operating system. For example, it may copy parts 

of itself to floppy disks, to the computer s hard drive, into legitimate computer programs, or it may attach itself to 

e-mail messages and spread across computer networks by infecting other shared drives. Viruses attached to e-mail 

messages can infect an entire local network in minutes (this is specifically called WORM).  

Thousands of viruses and worms exist and can quickly contaminate millions of computers. People who 

intentionally create viruses are computer experts called HACKERS; they also violate confidentiality by observing 

computer monitors and by impersonating authorised users in other to gain access to the user s computer databases 

to steal the identities of other people by obtaining privately identified information about them. They also engage in 

software piracy and deface website on the internet.  They develop powerful software  

crime tools such as the following:  

a. Internet eavesdropping snuffers which intercepts internet messages sent to other computers  

b. Password guessers that tries millions of combinations of characters in an effect to guess a computer s password.  

c. Vulnerability testers that look for software weaknesses  

d. Computer services saturator  

e. Automatic computer virus generator.   

Types of Viruses   

a. A boot sector virus stores itself at the start of a disk and becomes activated by reading, starting or restarting 

the computer when that disk is in the boot drive.     

b. A file infector virus attaches itself to program files i.e. files that give instructions to a computer. These files 

usually have extensions like exe, com, or bat. When the program is run, the virus executes.  

c. A macro virus affects data files, especially Word documents and Excel workbooks. This virus type accounts 

for the vast majority of infected files. When the infected document is opened and the macro are run, the virus 

is triggered and can perform system operations such as creating or deleting files or writing into already existing 

files and thus have the potential to cause a great  deal of damage.  

d. Worm or an email virus (for the purpose of this guide) is not really a virus at all (in that it is not selfreplicating) 

but a chain letter phenomenon sent through email. The message will, for some reason or other, tell you to pass 

this message on to as many people as possible. Hoax virus alerts are typical examples of chain emails. These 

are distinct from viruses in that they do not have host file like most other viruses but are carried on the internet 
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and can spread from one computer to another by themselves without the need for a user to assist the process by 

giving someone an infected file or disk. They are usually spread through the internet as an attachment.  

e. Trojan horses are programs that have some hidden, generally malicious functionality that the computer does 

not expect. They claim to be a thing (e.g. an audio for example), when they are actually another (e.g. code that 

will overwrite a portion of your hard disk). They do not run their own like a virus does but rely on tricking the 

user to run them. They don t also replicate themselves which is a major distinction between a virus and a Trojan.  

How Viruses are Spread   

Viruses are spread by running infected programs or opening infected files. This can occur by using any of the 

following methods:   

Passing floppy disks from PC to PC   

Downloading (copying) infected files from the Internet  

Opening an email attachment   

Booting a PC with an infected bootable disk.  

Computer viruses work in two phases: infection phase and the attack phase.  

Infection phase: in order to infect a computer, a virus has to possess the chance to get executed before it can infect 

the computer system and spread to others. Events that can trigger the execution of virus are included above.   

Attack phase: viruses do destructive things such as deleting files, erasing data on a hard disk, sending random emails 

or slowing down the processor by sending millions of looped instructions. Since most users will try their best to 

delete the virus once it launches the attack, most virus delay revealing their presence by launching their attack only 

after they have had ample opportunity to spread. This means the attack may be delayed for a long time after the 

infection.  

Prevention of Computer Virus   

Computer users can prepare for a viral infection by creating backups of legitimate original software and 

data files regularly so that the computer system can be restored if necessary. However, the best prevention may be 

the installation of current and well-designed antiviral software. Such software can prevent a viral infection and 

thereby help stop its spread.  

Or obtain a virus checker for your own machine then register the program with the manufacturers. They will 

regularly send you updated versions of the software while your agreement is current. New viruses keep appearing, 

so out of date virus software will not protect you and the checker is essential. Install the available security patches, 

particularly for Microsoft products. Keep your floppy disk write-protected whenever possible.  If you are really 

cautious, change the set-up option in your computer s BIOS so that it will always boot from the hard disk, not from 

floppies.   

Write protect MS Word s Normal template to get limited protection against macro viruses. This template will be a 

file called Normal.dot. Select the Read Only bod. Note that this will not disinfect existing infected files.   
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In Word, turn on the Macro Virus Protection Option in Tools, then Options, then Security Tab and finally Macro 

Security button, by setting the level of security you desire for the macros.. This will warn you if files contain macros. 

You or a colleague may have created the macros for some legitimate purpose but they could also be viruses. If a 

warning appears, open the file only it comes from a trusted source. Note that this procedure will warn you about 

macros (whether malicious or benign) but will not disinfect existing infected files.  

Virus Detection   

Several types of antiviral software can be used to detect the presence of a virus. Scanning software can recognize 

the characteristics of a virus s computer code and look for these characteristics in the computer s files. Antivirus 

software packages provide complete protection against viruses. Other types of antiviral software include monitoring 

software and integrity-shell software. Monitoring software is different from scanning software. It detects illegal or 

potentially damaging viral activities such as overwriting computer files or reformatting the computer s hard drive.   

COMPUTER SECURITY  

These are techniques developed to safeguard information and information systems stored on computers. 

Potential threats include the destruction of computer hardware and software and the loss, modification, theft, 

unauthorized use, observation, or disclosure of computer data.   

I Simple Techniques: A variety of simple techniques can help prevent computer crimes, such as protecting 

computer screens from observation, keeping printed information and computers in locked facilities, backing up 

copies of data files and software, and clearing desktops of sensitive information and materials.  

Increasingly, however, more sophisticated methods are needed to prevent computer crimes. These include 

using encryption techniques, establishing software usage permissions, mandating passwords, and installing 

firewalls and intrusion detection systems. In addition, controls within application systems and disaster 

recovery plans are also necessary.  

II Backup: Storing backup copies of software and data and having backup computer and communication 

capabilities are important basic safeguards because the data can then be restored if it was altered or destroyed 

by a computer crime or accident. Computer data should be backed up frequently and should be stored nearby 

in secure locations in case of damage at the primary site. Transporting sensitive data to storage locations 

should also be done securely.   

III Encryption: Another technique to protect confidential information is encryption. Computer users can 

scramble information to prevent unauthorized users from accessing it. Authorized users can unscramble the 

information when needed by using a secret code called a key. Without the key the scrambled information 

would be impossible or very difficult to unscramble. A more complex form of encryption uses two keys, called 

the public key and the private key, and a system of double encryption. Each participant possesses a secret, 

private key and a public key that is known to potential recipients. Both keys are used to encrypt, and matching 

keys are used to decrypt the message. However, the advantage over the single-key method lies with the private 

keys, which are never shared and so cannot be intercepted.   

IV Approved Users: Another technique to help prevent abuse and misuse of computer data is to limit the use of 

computers and data files to approved persons. Security software can verify the identity of computer users and 

limit their privileges to use, view, and alter files. The software also securely records their actions to establish 

accountability. Military organizations give access rights to classified, confidential, secret, or top-secret 

information according to the corresponding security clearance level of the user. Other types of organizations 

also classify information and specify different degrees of protection.  

V Passwords: Passwords are confidential sequences of characters that allow approved persons to make use of 

specified computers, software, or information. To be effective, passwords must be difficult to guess and should 

not be found in dictionaries. Effective passwords contain a variety of characters and symbols that are not part 
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of the alphabet. Another advantage of this password is because it is case sensitive (i.e. Advent is different from 

advent). To thwart imposters, computer systems usually limit the number of attempts and restrict the time it 

takes to enter the correct password.  

VI Firewalls: Computers connected to the communication networks such as internet are vulnerable to electronic 

attack because many people have access to them. They can be protected by firewalls computer software placed 

between the networked computers and the networks. The firewalls examines filters and reports on all 

information passing through the network to ensure its appropriateness. These functions help to prevent 

saturation of input capabilities that might otherwise deny usage to legitimate users.  

VII Intrusion Detection Systems: These are software that detect unusual and suspicious activities and in 

some cases, stop a variety of harmful actions.  

BASIC COMPUTER MAINTENANCE  

MAINTENANCE  

One of the most common questions computer users ask is, How do I maintain my computer and keep it 

running great? A computer is a lot like a car...it costs more than you think it should, it starts going down in value 

as soon as you bring it home and it requires regular maintenance to keep it running smoothly.  

To properly deal with repairable systems, we need to first understand how components in these systems are 

restored (i.e. the maintenance actions that the components undergo). In general, maintenance is defined as any 

action that restores failed units to an operational condition or retains non-failed units in an operational state. For 

repairable systems, maintenance plays a vital role in the life of a system. It affects the system s overall reliability, 

availability, downtime, cost of operation, etc. Generally, maintenance actions can be divided into three types: 

corrective maintenance, preventive maintenance and inspections.  

Preventive Maintenance  

Preventive maintenance is the practice of replacing components or subsystems before they fail in order to promote 

continuous system operation. The schedule for preventive maintenance is based on observation of past system 

behaviour, component wear-out mechanisms and knowledge of which components are vital to continued system 

operation. Cost is always a factor in the scheduling of preventive maintenance. In many circumstances, it is 

financially more sensible to replace parts or components that have not failed at predetermined intervals rather than 

to wait for a system failure that may result in a costly disruption in operations.   

Here are a few basic guidelines required.  

I Surge Protection: Power surges, spikes, lightning and brown - outs are all things that can literally burn up 

your computer and its peripherals. Save yourself lots of money in repairs by buying a decent surge protector 

(a.k.a.  Power strip) for your computer and use it. A UPS (uninterruptible power supply), though slightly more 

expensive, is even better.  

II Anti-Virus Protection: Everyone should know about this by now, but we often see computers with either no 

virus protection at all, or anti-virus software that is badly out-of-date . Nothing can wreck your  

computer faster than a virus (except for may be electricity), but with a small investment in good anti-virus 

software and making sure you set it to update itself daily.  

III Minimize the number of Software you install:  This is another thing many people overlook. Installing lots of 

programs on your computer is a lot like pulling a bunch of rowdy children together on a playground. Some of 

them may not play well together. A good rule of thumb is if you don t need, don t install. This is especially true 

when you surf the web. You will likely get bombarded with pop-up ads trying to get you to install all kinds of 

flee utilities they claim your computer can t live without most of these are spyware, adware and junk.  
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IV Backup your important files: To minimize the potential of loosing important information, always make a 

backup of your crucial files. To do this, you can use a CD-burner, a backup tape system, or a removable disk 

drive (such as a Jazz, Zip, floppy or flash drive). Keep copies of these backups in another location, just in case 

you need to perform a disaster recovery.  

V Firewall Protection: Symantec s Norton personal Firewall keeps personal data in and hackers out. Right out 

of the box, it makes your PC invisible on the Internet so that hackers can t find it. The program s Intelligent 

Intrusion prevention technology blocks suspicious Internet traffic. And easy-to-use privacy controls prevent 

personal information from being sent out without your knowledge.  

VI Internal/External Component Cleaning: Dust is one of the leading causes of hardware failure. All moving 

components are thoroughly cleaned and lubricated during service visits. The case is opened and dust is 

removed from the motherboard and all system boards. The CPU fan, power supply fan and any other board 

fans are cleaned, lubricated and tested. All data cables are checked to be sure they are securely heated on 

system boards. CD and floppy drives are opened, cleaned and tested for data transfer. External components 

such as keyboard, mouse, monitor and printers are cleaned of dust and debris and all cable connections are 

checked. Connections to surge protectors or UPS are checked.  

VII Scan and defragment your hard drive on arrive: Your hard drive stores information in open areas of 

your hard drive. As you delete data on your drive, open space appears. The computer will utilize this open 

space to store new information. Sometimes information for a particular file or application is separated on a 

drive into several different locations. The totality of the information may not fit in the open space in one area, 

so the computer will divide the information into several pieces. When you scan and defragment your hard 

drive, you are minimizing the risk of having problems and slowdowns caused by separated data on your hard 

drive. The defragmentation will locate, delete open spaces and place associated files back together again, 

helping your computer to run smoothly and faster. To do this, Right-Click on the drive➔Properties➔Tools 

Tab➔Defragmentation section➔Defragment now➔select the drive➔Analyze OR Defragment    

  

 
  

Disk Defragmenter  

Disk Defragmenter is a system utility for analyzing local volumes (an area of storage on a hard disk. A volume is 

formatted by using a file system, such as FAT or NTFS, and has a drive letter assigned to it. You can view the 

content of a volume by clicking its icon in windows Explorer or in My Computer. a single hard disk can have 

multiple volumes, and volumes can also span multiple disks) and locating and consolidating fragmented files and 

folders. You can also defragment (Defragmentation is the process of rewriting parts of a file to contiguous sectors 

on a hard disk to increase the speed of access and retrieval. When files are updated, the computer tends to save 

these updates on the largest continuous space on the hard disk, which is often on a different sector than other parts 

of the file. When files are thus fragmented, the computer must search the hard disk each time the file is opened to 

find all of the file s parts, which slows down response time) disks from a command line using the defrag 

command. The best practices for fragmenting a volume are enumerated below.  

 Analyzing before defragmenting  

Analyze volumes before defragmenting them. After analyzing a volume, a dialog box tells you the percentage 

of fragmented files and folders on the volume and recommends whether to defragment the volume. Analyze 

volumes regularly and defragment them only when Disk Defragmenter recommends it. A good guideline is to 

analyze volumes at least once a week. If you seldom need to defragment volumes, analyze volumes monthly 

instead of weekly.   
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 Analyzing after large numbers of files are added  

Volumes might become excessively fragmented when users add a large number of files or folders, so be sure 

to analyze volumes after this happens. Generally, volumes on busy file servers should be defragmented more 

often than those on single-user workstations.   

 Ensure that your disk has at least 15% free space  

A volume must have at least 15% free space for Disk Defragmenter to completely and adequately defragment 

it. Disk Defragmenter uses this space as a sorting area for file fragments. If a volume has less than 15% free 

space, Disk Defragmenter will only partially defragment it. To increase the free space on a volume, delete 

unneeded files or move them to another disk.   

 Defragmenting during low-usage periods  

Defragment file server volumes during low-volume usage periods to minimize the effect that the 

defragmentation process has on file server performance. The time that Disk Defragmenter takes to defragment 

a volume depends on several factors, including the size of the volume, the number of files on the volume, the 

number of fragmented files, and available system resources.   

 Defragmenting after installing software or installing Windows  

Defragment volumes after installing software or after performing an upgrade or clean install of Windows. 

Volumes often become fragmented after installing software, so running Disk Defragmenter helps to ensure 

the best file system performance.  

  

Defrag  

At times, it might be difficult to even select the drive to be defragmented; hence the use of command line. 

Locates and consolidates fragmented boot files, data files, and folders on local volumes. Syntax defrag 

volume; defrag volume [/a]; defrag volume [/a] [/v]; defrag volume [/v]; defrag volume [/f]  

Parameters definitions  

VolumeThe drive letter or a mount point of the volume to be defragmented.   

/a   Analyzes the volume and displays a summary of the analysis report.   

/v   Displays the complete analysis and defragmentation reports. When used in combination with /a, displays 

only the analysis report. When used alone, displays both the analysis and defragmentation reports.  

/f   Forces defragmentation of the volume regardless of whether it needs to be defragmented.   

/?   Displays help at the command prompt.   

Remarks  

• A volume must have at least 15% free space for defrag to completely and adequately defragment it. Defrag 

uses this space as a sorting area for file fragments. If a volume has less than 15% free space, defrag will only 

partially defragment it. To increase the free space on a volume, delete unneeded files or move them to another 

disk.   

• You cannot defragment volumes that the file system has marked as dirty, which indicates possible corruption. 

You must run chkdsk on a dirty volume before you can defragment it. You can determine if a volume is dirty 

by using the fsutil dirty query command.  

• While defrag is analyzing and defragmenting a volume, it displays a blinking cursor. When defrag has finished 

analyzing and defragmenting the volume, it displays the analysis report, the defragmentation report, or both 

reports, and then exits to the command prompt.   
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• By default, defrag displays a summary of both the analysis and defragmentation reports if you do not specify 

the /a or /v parameters.   

• You can send the reports to a text file by typing >filename.txt, where filename.txt is a file name you specify. 

For example: defrag volume /v >filename.txt  

• To interrupt the defragmentation process, at the command line, press CTRL+C.   

• Running the defrag command and Disk Defragmenter are mutually exclusive. If you are using Disk 

Defragmenter to defragment a volume and you run the defrag command at a command-line, the defrag 

command fails. Conversely, if you run the defrag command and open Disk Defragmenter, the defragmentation 

options in Disk Defragmenter are unavailable.   

Formatting legend  

Format  Meaning  

Italic  Information that the user must supply  

Bold  Elements that the user must type exactly as shown  

Ellipsis (...)  Parameter that can be repeated several times in a command line  

Between brackets ([])  Optional items  

Between braces ({}); choices separated by  

Set of choices from which the user must choose only one  

pipe (|). Example: {even|odd}  

Courier font  Code or program output  

  

VIII Checking Errors on the Hard Drive: this is done to rectify bad sectors. To do this, Right-Click on the 

drive➔Properties➔Tools Tab➔Error-Checking Sector➔Check Now➔Automatically fix file system errors 

OR Scan for and attempt recovery of bad sectors➔Start  

Corrective Maintenance  

Corrective maintenance consists of the action(s) taken to restore a failed system to operational status. This 

usually involves replacing or repairing the component that is responsible for the failure of the overall system. 

Corrective maintenance is performed at unpredictable intervals because a component s failure time is not known at 

prior. The objective of corrective maintenance is to restore the system to satisfactory operation within the shortest 

possible time. Corrective maintenance is typically carried out in three steps:  

i. Diagnosis of the problem. The maintenance technician must take time to locate the failed parts or otherwise 

satisfactorily assess the cause of the system failure.  

ii. Repair and/or replacement of faulty component(s). Once the cause of system failure has been 

determined, action must be taken to address the cause, usually by replacing or repairing the components 

that caused the system to fail.  

iii. Verification of the repair action. Once the components in question have been repaired or replaced, the 

maintenance technician must verify that the system is again successfully operating.  

System Diagnosis  

The diagnosis practice is usually called troubleshooting. Much of the troubleshooting guide treated here 

caters for users of Windows operating systems.  
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Always keep detailed records of all errors and steps taken to correct these errors. Error numbers and codes 

are important to log. They tell technicians/network administrators specific information about the problems you are 

having. To document errors, press the Details button or simply write down the first couple of lines of information 

given in the error screen.  

Check all cables first. The most frequent problem with computers is a loose or disconnected cable. Don t be 

afraid to make mistakes. Don t let the machine intimidate you. Before calling an expert for technical support, always 

shut your computer down totally and reboot; wait until the CPU is not making any sounds and then turn it on again, 

by pressing the power button.  

1. Booting Problems  

When you press the power button, you give the instruction to the electricity to "wake" up the computer. This 

instruction causes the computer to start giving its own instructions to internal parts. One of the instructions is 

called BIOS. The BIOS instruction starts checking "everybody", asking "Are you OK?", "Are you OK?", "What 

about you?". If a certain part that is important doesn't respond (for example if a certain important object such as 

the keyboard or mouse is not connected, which means it will not respond when the BIOS asks, "Are you OK?"), 

then the BIOS may interrupt everything, or it may continue checking. If the BIOS comes to a conclusion that this 

computer is not worth using, it would display an error and may not let you do anything significant. If the  

BIOS "thinks" that everything is alright and that the computer can be used, then it gets the hardware parts ready.  

a. I am receiving an error that says, Invalid system disk, replace and press any key when ready: This error is 

caused by the presence of a floppy disk in the floppy drive while the computer is booting up. Whenever you 

turn your computer on, remember to eject all disks from the floppy drive (unless a bootable floppy disk). If 

you get this error, eject the floppy disk and hit enter. Your computer should continue to boot as normal.  

b. Receiving a keyboard related error: This error occurs when the keyboard has become unattached from the 

rear of the computer. Check behind the computer to see if your keyboard is still firmly attached to the 

computer. Also check to see if something has been pressing on top of the keyboard during booting. Remove 

all items that are pressing keys and re-plug the keyboard into the computer. Restart your computer.  

c. I am receiving a no signal error, or there are no visuals on my monitor : A no signal error means that the 

monitor is .not receiving a signal from the computer. Check to see if the computer is on and running. Then 

check the connection (cord) between the computer and the monitor. If everything is connected, turned on, 

and running, then there might be an internal error causing this error to occur.  

Contact a technician for assistance  

d. Scan disk appears on a blue screen, stating that Windows was not properly shut down:  Scan Disk is a 

utility that Windows runs automatically when it thinks there might be a problem with your system. This does 

not mean that there is a problem, but Windows will automatically take this step to ensure that the problem is 

rectified. Let Scan Disk run and wait, to see if your machine will boot properly after scan disk is complete. If 

it does not, turn the computer off, and reboot to see if the problem clears up on its own. If rebooting the 

computer does not solve the problem, contact your technician.  

2. Safe Mode Problems  

If your computer boots to a screen giving you a choice to boot into safe mode, or it automatically boots into 

safe mode, Windows has run into an error that it cannot bypass to run smoothly. In most cases, you can reboot 

and the problem will resolve itself automatically. If you continue to get the safe mode screen, or it goes away 

and comes back frequently, then contact your technician.  .  

3. The system is ON but it Is not responding  

My system is locked and nothing I press or click is working. What now? Sometimes your computer will stop 

responding, or freeze , either during operation or after unused for a period of time. If the computer has not 

been used recently, press a few keys and wait several minutes. If the computer freezes during operation, stop 

using the keyboard and the mouse for several minutes. If you continue to use the computer when it is frozen , 
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it will prolong your waiting period. If, after waiting for several minutes, you cannot get your computer to 

respond by using the keyboard or the mouse, turn the computer off by pressing the power button on the front 

of the machine. Let the computer shutdown (the CPU is no longer making any sounds) and then reboot. If you 

still get no response from the machine, your mouse and keyboard may have become dislodged from the rear 

of the machine, check those connections and reboot again. If the computer freezes again after plugging the 

mouse and keyboard into the back of the computer and rebooting, contact your technician.  

4. Rebooting Problems  

a. Windows won t shut down, it stays at the please wait screen, or won t power down: This is a problem  

with the way Windows is talking to your computer. The computer wants to suspend activity, but Windows 

is telling it to shut down. This is causing confusion for the computer. In some cases, this can be solved with 

a patch from the Microsoft web site. A patch is an update to a software product that fixes a known problem. 

You can get this update by downloading it from www.Microsoft.com. Windows 98 generally has a problem 

with shutting down, especially when the computer is attached to a network. Generally, this doesn t hurt 

anything. It is just a bit of a nuisance. See Booting Problems on what to do during subsequent reboots.  

b. A window pops up with End Task, Shut Down, and Cancel buttons, what do I do? This message usually 

appears when you press and hold Control , Alt , and Delete while running an application or program. This 

keystroke tells the computer to shut itself down, despite the fact that applications are running. If you would 

like to turn off the computer without manually closing or saving anything, click the  

Shut Down button. If you would like to close just the program you are running currently, ensure that the 

correct program is highlighted in the box and click End Task. If this window was opened accidentally, click 

Cancel and you will return to the program you were just using.  

c. An internal error or KernaI32 error box appears suggesting that I restart Windows: This error has occurred 

because Windows has come across an error that it cannot continue with. If something like this happens and 

you are in the middle of your work, try to save your work before you click OK . If your work caused the 

error to occur, everything, after the last time you saved your work, will be lost. Restart your computer. 

Remember to always document errors thoroughly. Misbehaving software often causes these errors. If the 

error occurs repeatedly, call for assistance from your technician.  

5. Monitor Problems  

My monitor has no display, the monitor turned off for no reason, or my display is faded: Ensure that the 

monitor and the computer are turned on. Next, check both the power cord to the monitor and the power cord to 

the computer. If you are using a power strip, ensure that it is turned on. You can also check the settings on your 

monitor (the buttons are located on the lower front of the monitor). Check the contrast and tint to see if they are 

set correctly. Next, check the connection between the monitor and computer; at the rear of the computer (this is 

the cord that connects the monitor to the computer). The next thing to check is your screen saver settings. Right 

click on your desktop➔Properties or you can click Start➔Settings➔Control Panel➔Display (display settings 

dialog box will appear) ➔Screen Saver tab. Make sure your screen saver is set to go off in a reasonable amount 

of time (usually 10 minutes or more). Also, make sure your Energy Savings settings are marked correctly. You 

can locate the energy savings settings button in the Screen Saver box, near the bottom. When you click on  

Settings , you will be able to adjust the amount of time that your computer waits to turn off the monitor if the 

computer is not in use. If you don t ever want the monitor to be shut down by the energy saver mode, choose 

Never. If all these things don t fix the problem, contact a technician.  

6. Monitor flashes on and off  

Usually this is caused by a loose or bad connection at the back of your computer. You should be able to 

retighten the connection, and continue as normal. If that is not the problem, then it needs to be diagnosed by a 

professional.  

7. Mouse Problems  

http://www.microsoft.com./
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a. My mouse is sticky and/or the cursor won t move Check to see if your mouse cord is pulled too tightly. If 

your cord doesn t have enough room to maneuver, then you will have less control over it. Next, check the 

mouse s connection to the back of the CPU and ensure that it is plugged in. If neither of these possibilities 

were the problem, you may need to clean the ball on the inside of the mouse. You can flip over the mouse 

and take the ball out by twisting the round disc that holds it in place (turn the round piece in the direction of 

the arrows). Once you have taken out the ball, clean the ball off with a clean, dry, and lint-free cloth. Never 

use water on any computer part! Put the mouse back together again. If that doesn t fettle problem, it might 

be time to replace the mouse.  

b. My mouse won t right click, or won t double click: Press Ctrl-Alt-Esc and use the arrow key up to get to 

Shutdown, and then choose reboot. This should fix the problem, if not a technician should look at the 

machine.  

8. Keyboard Problems  

a. I am receiving a keyboard error when booting my computer: This is usually caused by a key being pushed 

down while the computer starts. Make sure nothing is on top of the keyboard during boot time. Also this 

could be caused by the keyboard becoming disconnected from the back of the computer. If neither of these 

are the problem, contact your technician.  

b. My Keyboard won t respond at all: If your computer has frozen and the keyboard will not respond at all, the 

first thing to do is to check the keyboard connection to the computer and restart the computer. If your 

keyboard still does not respond, you may need technical assistance.  

9. Printer Problems  

a. The printer won t print my document: Check the printer to make sure it is plugged in and turned on. Click 

Start➔Settings➔Printers. If the printer you want to use is not listed, you will have to install that printer. 

You can do this by clicking Add Printer and following the installation process through to completion. If the 

printer appears light or grayed-out, your printer is offline. Double-click on the printer in question, then click 

Printer and uncheck Pause Printing and Use Printer Offline or Right-Click the printer and select Online. 

Next, make sure that you have chosen the correct printer. You can check this by going back into the file you 

were trying to print and click on File➔Print. The name of the printer will appear near the top of that 

window next to Name . If the correct printer does not appear in this box, click on the down arrow to the 

right of the name of the printer being used. Find your printer s name and highlight it by clicking the left 

mouse button on it. Once you have ensured that the correct printer is chosen and that the printer is not 

offline or paused, ensure that you are logged onto the network. To do this, click Start and look to see if your 

logon name is listed after Log Off . If your logon name is not there, you need to log back onto the network. 

To start this process, ensure that you have saved your work. Then, click Start➔Log Off. This will bring up 

a dialog box. Click Yes. You will be prompted to enter your name and password to log back onto the 

network. Once you finish this, click Ok or Enter. Open your file again and try to print it. If you still cannot 

print, please call a technician.  

b. Documents come out faded or striped: This is usually due to dirty or clogged print heads, or the printer 

being out of ink. Try running a print-head cleaning utility to clean the heads. Most printers come with this 

to help with dirty or clogged heads. Do this by going to Start➔Settings➔Printers, and then right clicking 

on the printer in question. Try cleaning the heads, and then print a page. If you still get fades or stripes, try it 

once more. If after two times your pages are still coming out faded or striped, then you may need to replace 

the ink. If, however, the ink is not an issue, you should contact a professional.  

c. I am receiving an out of memory error or a spooter error: This is caused when the machine that the printer is 

connected to runs out of memory, or has an internal error. This usually happens because of large print jobs. 

If you get this error frequently you might want to consider upgrading the memory on the computer with the 

printer attached to it. It can also be caused by lack of free disk space. Check to see if  

you have enough free space. To do this, double click on My Computer➔Right-Click C  
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Drive➔Properties. The free space should be listed on that screen. If you only have a couple of megabytes 

or less, that could be your problem. You will need to either clean up your drive or replace it with a bigger 

drive. Call a technician to help with either of these processes. If you have adequate disk space, try 

uninstalling and then reinstalling the printer. To do this, Click Start➔Settings➔Printers➔Right-Click on 

the printer in question and select Delete. You want to remove it completely from the system. Then click Add 

Printer and reinstall the same printer. If it was used across a network make sure you reestablish the share 

with the same name. This can be done by right clicking on the printer and choosing Share This Printer .  

10.  CD-Rom Issues  

a. I have no audio and/or my CD player won t come on when playing an audio CD: First, check to see if your 

speakers are turned on and the volume levels are adequate. At the Task bar tray is a little speaker, double 

click it to get its properties. Make sure the volume levels are turned up and that none of the controls are 

muted. Next, look at the back of the computer where the speakers plug in. If there is a volume control there, 

make sure it is turned up. Then check to see if the speakers are plugged into the correct jack for audio out. 

There are usually three jacks on the back of a sound card plug as appropriate. Next, we want to open the CD 

player application by clicking Start➔Programs➔Accessories➔Entertainment➔CD Player. If the 

application will not open, you will need to reinstall the CD player application of the  

Windows CD. You can do that by going into Start➔Settings➔Control Panel➔Add/Remove  

Programs➔Windows Setup➔Multimedia➔Details. You should see the CD Player checked (if it is not, 

check it and click ok and then apply), uncheck it and click Ok. Then click Apply, but don t shut the panel. 

We now need to go back to Multimedia and recheck the CD Player, click Ok, and then click Apply again. If 

this was not the issue, contact your technician.  

b. I am receiving a CD ROM is not accessible error: Check to see if you have placed the CD you want to read 

in the CD ROM drive. Pick up the CD and check to see if it is dirty, or scratched. If your CD is clean and 

fully inserted in the drive, try to read from the drive again. You can also insert another CD into the drive 

and try to read the new CD. Some burned CDs cannot be read by certain CD R0M drives. If your issue goes 

unresolved, call a professional for assistance.  

Inspections  

Inspections are used in order to uncover hidden failures (also called dormant failures). In general, no maintenance 

action is performed on the component during an inspection unless the component is found failed, in which case a 

corrective maintenance action is initiated. However, there might be cases where a partial restoration of the inspected 

item would be performed during an inspection. For example, when checking the motor oil in a car between 

scheduled oil changes, one might occasionally add some oil in order to keep it at a constant level.   

About Backups   

A backup is a copy of your file, made in case you lose or damage the original. For those using system in offices or 

at home, it will be necessary to follow a strict backup regime, using floppy disks or ZIP disks, Flash drives and 

other secondary memory devices. A zip disk is like a floppy disk except that it hold 70 times as much information: 

obviously useful for graphics and multimedia projects. A flash drive can hold larger information than a ZIP drive.   

Be Disciplined   

It requires discipline from the user for a backup strategy to work. Make backups at the end of every day or every 

week depending on how much work you do and how important the data is. To make backups of individual files, 

copy them to disk using Explorer or My Computer. Note that you can also copy entire folders with this method. 
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Alternatively, open the file and use the Save as option in the application perhaps the most convenient method is to 

make a copy of the Zip or floppy disk, using Copy Disk.  

Don t work directly with backup files (i.e. Zip/floppy disk), you work on the hard disk and thereafter  

copy to a ZIP or floppy disk.  We cannot stress enough just how important it is to make backups, horror stories exist 

when people loose months or years of work. Unfortunately even people, who know they should make backups, tend 

not to bother until they have been stung. So follow the advice in this book and be an exception to this tendency!     

WORKING WITH DESKTOP  

                           

 Figure 4: Window s Desktop          Figure 5: Display Properties Dialog Box  

The computer s interface uses a desktop metaphor. The desktop is the coloured background you see  

on the screen when you start your computer (this may vary for different computer since it is customizable). It is the 

place where you manipulate the work you are doing by handling icons (a little pictures that represent your files, 

folders, and disks). It summarises the systems properties by enabling you to have access to all these properties. It 

serves as an intermediary between the system and the user.   

The desktop elements include the icons, the taskbar (Start Menu, Taskbar and the System Tray) wallpaper 

and screen saver. The icons are images, pictures, symbols, or logos that represent items on the desktop. For instance, 

the desktop above has 30 icons. An icon may represent an application, a file, a folder, a shortcut or even a location 

on the hard drive. The taskbar is the horizontal (by default) bar placed separately on the desktop but will never 

appear on the screen saver. The wallpaper represents the picture used as the desktop image. It is the placeholder for 

the icons (i.e. the icons are placed on it). The screen saver is the animated picture shown instead of the wallpaper 

when the system is idle for some time. It differs from wallpaper in that it can t harbour the icons.  

There are two entities that mainly need to interact with icons:  

• As a person using the computer, icons allow you to familiarize with the various programs that are installed in 

a computer. Every application or every category of application has its own icon. This is easily possible 

because every person who creates an application has the possibility of providing a special icon for that 

particular application.   

• The operating system also has an interior mechanism to identify an icon or a type of icon and associate it with 

a particular application or a series of applications of the same type. Microsoft Windows ships with various 

icons for its own use. For example, every version of Microsoft Windows ships with a special icon for the My 

Computer program. There is also a special icon for Recycle Bin, etc.  

The sizes of icons are standardized and they should not have just any random dimensions. For example, the 

icons on the desktop are 32x32 pixels. Sometimes, the icons display in a 16x16 dimension.  
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You can customize your desktop s elements using the Display Properties Dialog box (shown above) which 

can be accessed by either Right-Clicking the desktop➔Properties or Start➔Control Panel➔DoubleClick on 

Display. This window will enable you to change the appearance of your desktop, such as the background 

(wallpaper), screen saver, colours, font sizes, and screen resolution. Use the various tabs to change the various 

properties.   

You can also right click any section of the taskbar and select Properties to customize it. This will display 

the Taskbar and Start Menu Properties Window where you can select the Tab you need as the case may be. To 

customize the System tray section, Click the Customize button on the Taskbar Tab of the window.  

WORKING WITH WINDOWS  

Working with windows gives you the ability to look at something. It allows you to look into a document, or 

a folder, or a disk. When you begin using your PC, you will be confronted with the desktop, which is simply the 

term used for the space on your screen. When you want to run a particular application, you need to load the package 

(launch). To do this depends on the location of the package. a. Desktop  

i. Click its icon/ press Enter  

ii. Double-click the icon  

iii. Right-click/open  

b. Start menu   

Start/All Programs/Navigate to where it resides/Select the application  

c. Quick Launch (this is just beside the start button for easy launch)  

Click on the icon once.  

d. Taskbar Tray (this is at the right on the task bar)  

Double-Click on the icon.  

Note that for all the methods, you double-click twice to launce any application. This is also true for any icon 

(files, folders or executables).  
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For any method you use, you ve performed some actions. Each action is stored in a particular program and 

kept under a button or a menu. A program's menu, simply referred to as a menu, is a series of words usually aligned 

on a (vertical) column, each line of words indicating a particular action.  

For any window you open, what is common to all packages is the title bar.  

There are different types of windows we will encounter when working with the computer. Some of them include a 

dialog box, a Single Document Interface (SDI), and a Multiple Document Interface (MDI).  

Dialog Boxes  

A Dialog Box is a square or rectangular window whose main role is to carry, hold, or host, other windows. 

The objects it carries define its role and name. A dialog box is made of two main sections. On top, it displays a 

Title Bar (with the title and System Close Button). By convention, a dialog box cannot be minimized or maximized. 

Therefore, it doesn't have those system buttons. Sometimes, a dialog box will have a button with a question mark 

(the Help button). A dialog box equipped with the Help button indicates that you can get quick help on the items 

displayed on the dialog box. The second section of a dialog box is its body (programmers call it the Client Area). 

This is the area where the objects the dialog box is hosting are positioned. Examples include the Save As Dialog 

Box and the Open Dialog Box in most applications.  

  

Figure 7: A Typical Dialog Box (The Run Dialog Box)  

Figure 6: Common Application Window   
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The Single Document Interface (SDI)  

This is a window that allows the user to work on only one opened document at a time. It is similar to a typical 

window. An example is the WordPad  

The Multiple Document Interface (MDI)  

This is similar to the SDI except that you can work on more than one document at a time. An example is the 

Microsoft Word.  

The Windows Controls  

The controls on a window refer to the objects that are available on the window. There are various controls to include 

Command buttons, Text boxes, List boxes, Option (Radio) buttons, Check boxes, Combo boxes, Scroll bars, 

Progress Bar, etc. For all the objects that may be present on a window, only one of them can receive focus at a time. 

The focus is a visual aspect that indicates that a control is ready to receive input from you. Various controls have 

different ways of expressing that they have received focus. Button-based controls indicate that they have focus by 

drawing a dotted rectangle around their text. In the following picture, the button on the right has focus. A text-based 

control indicates that it has focus by displaying a blinking cursor. A list-based control indicates that it has focus 

when one of its items has a surrounding dotted rectangle.  

To give focus to a control, you can click it. Alternatively, if the focus is already on one of the controls, to give focus 

to a particular control, you can press Tab continuously until the control shows that it has focus. On a browser, if 

you press Tab continuously, the focus would move from one link or control to another. This means that a link on a 

web page can receive focus as if it were a control.   

Main Menu Display  

We have just seen that, when you know where a menu is available, to access it, you can just click or right-

click the item that holds the menu. How a menu appears can be influenced by the available room. The operating 

system decides on the availability of room to display the menu. If a menu is accessed from the middle to top section 

of a window, the operating system would display it under the item that was clicked. If the menu is being accessed 

from the bottom section of the screen, the operating system would calculate the available room under the item that 

was clicked. If there is enough room, the menu would be displayed under the item that was clicked. If there is not 

enough room, then the operating system would decide to display the menu above the item that was clicked  

Categories of Menus   

To diversify the actions that can be performed on a computer, there are six main categories of menus, each of which 

depends on the person who created the menu.  

a) Stand-Alone Items: The simplest menu item displays a word or a group of words on its line. To use this menu 

type, you can simply click it. What happens depends on the program and the familiarity with it. Example is the 

Refresh menu on most browsers.  

b) Disabled Menu Items: If a menu appears gray, this means that the menu is not available at this time. Such a 

menu is said to be disabled. Clicking a disabled menu would not do anything, at all. Most of the time, such a 

menu would require a prerequisite action in order to become available or enabled.  

c) Ellipsis Menus ( ): A menu with three periods indicates that an intermediary action is required. To use such a 

menu, click it. Once clicked, sometimes another window would be displayed. Example is the Save As  option 

of the file menu in several windows.  
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d) Check Menus: A menu that appears with a check mark is used as a "witness" of a window object being available 

or not. This means that, when the check mark is set, the object the menu item refers to is visible. If you click 

such a menu item, the check mark disappears along with the item it refers to; the menu item is still visible: only 

its check mark and the item it refers to disappear.  

e) Radio Menus: Some menu items appear in a group of two or more (usually not more than 7). The group is 

delimited by a horizontal line above the top menu item and another horizontal line below the bottom object. At 

any time, one of the menu items has a big round dot on its left side. This dot is called a radio button. The item 

that is currently active has the radio button and the other menu items don't. If you click an item other than the 

one with the radio button, the dot moves to the item you clicked and the previous item looses the radio button. 

This type of menu is used when the programmer wants only one item of the group to indicate which item of a 

category is active.  

f) Arrow Menus: When a menu appears with an arrow, this means that the menu item holds its own list, called a 

submenu. Again, this design depends on the person who created the menu and is not subject to any 

preconceived rule. To access the menu item, simply position the mouse cursor on the menu item that has the 

arrow. How the submenu appears may depend on the section of the screen from where the menu is being 

accessed. The operating system decides how to display this submenu based on the available room.  

Main and Context-Sensitive Menus  

We have seen that a menu on the same object can be different depending on what item you click to access 

such a menu. Based on this, a menu that appears when you simply click an object is considered the regular menu 

of the object, and it is simply called the menu. Sometimes when you click or even right-click an object, a menu 

might not appear. On the other hand, if a menu appears when you right-click an item or an area of a window, this 

menu is referred to as the context-sensitive menu.  

Most applications display a menu in their top section, the Main Menu, below the Title Bar. The main menu 

displays columns of menus, each column is represented by a word (sometimes it will be more than one word for a 

menu item). To use this main menu, you can click a word. This causes a list of menu items to display. There are no 

strict rules (only suggestions) on what items must appear under what word. The person who creates an application 

also decides on the menu columns, their items, and their roles.  

After clicking a menu column, if you find the item you are looking for, you can click it. If you don't see the 

item you are looking for and you want to check another column, you have two options. You can simply move the 

mouse to another menu column of your choice. You can also click the menu item you had opened, then click the 

new column you desire. If you still don't see what you are looking for, you can dismiss the menu.  

There are various ways you can dismiss the menu if it is opened. If you click an item in the list of the 

displayed column, the menu would retract and close itself. If you have opened a menu but don't want to use it 

anymore, you can click one of the menu items on top. You can also click anywhere other than the opened menu; 

this also closes the menu.   

To access or close the menu using the keyboard, use Alt + the Access Key (underlined letter on the menu) 

for the menu. Once this is initiated, you just press the access key for each command under the main menu. To 

dismiss a displayed menu, press the Esc key. You can also use the navigation keys to move from menu to menu 

(Left and Right Arrows) or down a menu using the Up and Down Arrows.  

➢ The Control/System Buttons (located at the top right corner of a window)   

i. Minimize button: Click this to reduce the programs to a button on the Taskbar.   

ii. Restore/Maximize button: This switches the window size between full-screen size (docked window) and 

Half-Window (or customized) size (floating or cascade window). You can also double-click the empty 

space of the title bar to toggle between the options.  

iii. Close button: Click this to dispense with the window until the next time you open the program. If the file 

inside the window has not been saved, it will prompt you to save it.   
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You can also access any of the actions by clicking the application logo or right-clicking the empty space of the title 

bar and then select the action you want.      

➢ Moving Windows   

If a window gets in the way of what you are doing, you can move it to a different place on the screen by 

clicking and holding the Title bar using the Left Mouse button (only possible for floating window).       

You can change a windows shape or size so that you can see more of its contents or so that you can arrange 

windows side-by-side manually. This is possible when the window is restored down. Place the mouse over the edge 

of the window so that the mouse pointer changes shape to a double-pronged arrow (either side or edge), drag inwards 

or outwards to reduce or enlarge the window (default Restored).   

➢ Splitting Window  

This is usually done when you want to compare different places of a particular document. For instance, view 

pages 50 and 350 of a particular document at the same time. To do this, select Window➔split; the cursor will 

change to a horizontal line which you will click at the desired location. You can work on each of them as if you are 

dealing with a single window. To remove Window➔Remove split.  

  

➢ Arranging Windows  

For a particular document, more than one window can be opened simultaneously. To do this, select 

Window➔New Window. The new window will change the name of the document by adding index. The name will 

be like Filename:index_number e.g. Adebisi:1 while the second name will be Adebisi:2. You can add as many as 

you want. You can now arrange the window using Window➔Arrange All. This will arrange the windows 

horizontally. To change the arrangement to side-by-side, select Window➔Compare Side by Side. To change to 

horizontal, select Window➔Close Side by Side.  

Note that these two procedures may seem similar in that both are used for comparing a document in different 

windows. Thus, the major differences are:  

i. Splitting windows does not use name index; both bear the same name.  

ii. Splitting windows has only one title bar and toolbars while each window in New Window has its own title 

bar and toolbars.  

iii. Splitting windows can only be viewed horizontally whereas New Windows can be viewed in two ways (either 

horizontal or vertical).   

To arrange windows of different documents, Right-Click on the taskbar ➔ Choose either Cascade windows 

(all windows restored), Tile Windows Horizontally, Tile Windows Vertically, or Show the Desktop (all windows 

minimized).  
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➢ The Taskbar   

The taskbar appears at the bottom of the screen and displays all the programs that are currently open. When you 

minimize a window, it still appears as a button on the taskbar. Click the program button on the taskbar to restore 

it to a window. By selecting different program buttons on the taskbar, you can switch easily between currently 

open programs or press Alt + Tab key or WIN + Tab key + Enter.   

➢ The status bar  

The status bar, which is a horizontal area at the bottom of the document window (e.g. in Microsoft Word) which 

provides information about the current state of what you are viewing in the window and any other contextual 

information. To display the status bar, click Tools➔Options➔View tab➔select the Status bar check box under 

Show. The elements on the status bar for the above window include the following.  

i. Page number: Shows the page number.   

ii. Sec number: Shows the section number of the page shown in the window.   

iii. Number/number: Shows the page number and the total number of pages based on the physical page count 

in the document.   

iv. At measurement: Shows the distance from the top of the page to your insertion point. No measurement is 

displayed if the insertion point is not in the window.   

v. Ln number: Shows the line of text where the insertion point is located. No measurement is displayed if the 

insertion point is not in the window.   

vi. Col number: Shows the distance, in number of characters, from the left margin to the insertion point. No 

measurement is displayed if the insertion point is not in the window.   

vii. REC: Shows the macro recorder status. Double-click REC to turn the macro recorder on or off. When the 

recorder is off, REC appears dimmed.   

viii. TRK: Shows the track changes status. Double-click TRK to turn the Track Changes feature on or off. When 

changes are not being tracked, TRK appears dimmed.   

ix. EXT: Shows the extend selection mode status. Double-click EXT to turn the mode on or off. When selection 

mode is off, EXT appears dimmed.   

x. OVR: Shows the overtype mode status. Double-click OVR to turn the mode on or off. When overtype mode 

is off, OVR appears dimmed.   

xi. Spelling and Grammar: Shows the spelling and grammar checking status. When Word is in the process of 

checking for errors, an animated pen appears over the book. If no errors are found, a check mark appears. If 

an error is found, an X appears. To resolve the error, double-click this icon.   

xii. Background save: When a pulsating disk icon appears, Word is saving your document in the background as 

you work.  

xiii. Background print: When a printer icon appears, Word is printing your document in the background as you 

work. A number next to the printer icon shows the current page number being printed. To cancel the print 

job, double-click the printer icon.   

Note that the status bar are grouped into sections: Page (i, ii, and iii), Measurement (iv, v, vi), while others shows 

the current status of the commands.  

USING THE SYSTEM (BOOTING/SHUTTING DOWN)  

Turning the system ON (Booting) is very easy. It only requires you to press the On Button once. This button is 

usually the upper button in front of the system console. Before doing this, you must ensure that power supply has 
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entered into the power supply unit. To enforce this, switch on the UPS, turn the console box ON if there is ON/OFF 

button at the back of the box (optional).  

Shutting down has many options. The settings in the Shut Down Windows dialog box include Stand by,  

Hibernate, Shut down, Restart, Log off, and Disconnect. To display the Shut Down Windows dialog box, click 

Start➔Shut Down. Stand by and Hibernate appear only if your computer supports these features and you have 

turned them on in Power Options. Disconnect appears only if you are connected to a Windows Server running 

Terminal Services. On Windows 2000 Server products, you will be prompted to supply information regarding why 

you are shutting down or restarting the computer. This feature is turned off in Windows XP.  

Stand by mode: A state in which your computer consumes less electric power when it is idle, but remains available 

for immediate use. Typically, you put your computer on standby to save power instead of leaving it on for extended 

periods. In standby mode, information in computer memory is not saved on your hard disk. If the computer loses 

power, the information in memory will be lost. This option appears only if your computer supports this feature and 

you have selected this option in Power Options.  

Hibernate: A state in which your computer saves any Windows settings that you changed, writes any information 

that is currently stored in memory to your hard disk, and turns off your computer. Unlike shutting down, when you 

restart your computer, your desktop is restored exactly as it was before hibernation.  

Shutdown: A state in which your computer saves any Windows settings that you changed and writes any 

information that is currently stored in memory to your hard disk. This prepares your computer to be turned off.  

Restart: A state in which your computer saves any Windows settings that you changed, writes any information that 

is currently stored in memory to your hard disk, and then restarts your computer.  

Log off: A state in which your computer closes all your programs, disconnects your computer from the network, 

and prepares your computer to be used by someone else. When connected to a Windows 2000 Server running 

Terminal Services, Log off closes all programs running in your Terminal Services session, disconnects your session, 

and returns you to your Windows desktop.  

Disconnect: A state in which your Terminal Services session is disconnected, but remains active on the server.  

When you reconnect to Terminal Services, you are returned to the same session, and everything looks exactly as it 

did before you disconnected.  

Make sure that you always shut the system down in the normal way, else you are hastening to destroy the system 

especially when you are using Window XP.  

INTRODUCTION TO THE INTERNET  

Computer Network (Networking and Internetworking)   

Until recently, getting a computer was mostly equivalent to getting a machine that would be used to perform 

office-related assignments and other calculations. This type of computer was commonly referred to as standalone. 

A network is a group of computers linked together so that they can share resources such as printers, software 

programs and documents. Computer network is the interconnectivity of autonomous computers. In order for two 

computers to share what they have, they must establish some type of communication. This is easily done using a 

cable and an appropriate object (a network card, also called NIC) inserted in each computer. This means that a cable 

would go from this object of one computer to the same type of object on the other computer. This is perfectly 

possible to connect two computers. If you have more than two computers, then you use a type of intermediary object 
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whose job is to "direct traffic". This object is called a hub. For example, when one computer A requests to use or 

open a piece of text that is located in a computer B but to print it in a printer that is connected to a computer C, this 

intermediary object is able to know what computer has the text, what computer has the printer, and what computer 

needs these two services. For these reasons, most connections use this intermediary object: the hub  

There are two types of networking relationship: computer workstations (clients) are connected to a number 

of central network servers, which allocate resources. In a peer-to-peer relationship, computer workstations serve 

each other: one workstation may have access to a printer and allocates this resource to others in the network; another 

may have access to file storage and allocates this to others (including the workstation with the printer).    

  
Figure 8: Connection of Computers using the Hub  

Only computers that are connected can share what they have. A computer A that is connected to a computer 

B can access what computer B has. When two or more computers are connected, the idea is to let them share and 

exchange what they contain. If the computers are small, like regular desktop computers, they may become 

overwhelmed and they may not have enough to share. The next step is to have a "bigger" central computer that 

holds even more things that other small computers would need (the word big here doesn't necessarily mean that this 

computer is physically big; it implies that this computer can do more things, for example it can perform more and 

faster calculations, than the other small computers). Such a central computer is called a server, because its job is to 

serve other computers (these other small computers are then called workstations):  

As information and resources (things to share) became more and more useful and in demand, servers of 

different companies started establishing types of connections among themselves, of course following some rules. 

In fact, in some situations, some big computers (servers) were made simply to provide information to other 

computers, without needing to know who owned these small computers, why these small computers needed this 

information, or what to do with them. The internet was born.  

The Internet is a group of big computers connected to share the information they hold. Some of these 

computers belong to the government, schools (mostly universities), big companies (corporations), small companies 

and some to individuals. The computers that are connected may not have anything at all in common. To make sure 

that this communication is possible, a few rules (called protocols) were established so that anybody who wants to 

make his or her information available to other people through the Internet must follow these rules, no matter what 

he or she does with the server or computer.  

The rules to make a server available on the Internet are numerous and complicated. Therefore, another type 

of computers was created that allows casual users to get on the internet without knowing, or being interested to 

know how these servers communicate. These new intermediate computers are held by companies called service 

providers (they are the middle man). When you have a computer and want to get on the internet, you use an Internet 

Service Provider (ISP) who will establish the connection for you and will make sure that your computer can get on 

the Internet. Based on this, the Internet can be illustrated as follows:  



Computer Training  Expert Solution Consults  Computer Basics  

37/59, Nov - 2010    Learn to Know Why and How!   adebisijeleel@yahoo.com or 

adebisijeleel@gmail.com  

      

  

Figure 9: The internet  

The advantages of using a network are:    

a) Data and information sharing   

b) Resources sharing such as a printer, even if they are not physically connected. c) Reliability and 

security  

d) You can use email    

e) You can access the internet   

TYPES OF NETWORKS  

In describing the basics of networking technology, it will be helpful to explain the different types of networks in 

use.   

Local Area Networks (LANS)  

A net work is any collection of independent computers that exchange information with, each other over a shared 

communication medium. Local Area Networks or LANs are usually confined to a limited geographic area, such as 

a single building or a college campus. LANs can be small, linking as few as three computers, but can often link 

hundreds of computers used by thousands of people. The development of standard networking protocols and media 

has resulted in worldwide proliferation of LANs throughout business and educational organizations.  

There is another advance LAN called the Metropolitan Area Network (MAN), used when we consider the distance 

covered to be between 1 to 10km unlike the LAN that spans within 1km.  

Wide Area Networks (WANS)  

Often elements of a network are widely separated physically. Wide area networking combines multiple LANs that 

are geographically separate. This is accomplished by connecting the several LANs with dedicated leased lines such 
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as a T1 or a T3, by dial-up phone lines (both synchronous and asynchronous), by satellite links and by data packet 

carrier services. WANs can be as simple as a modem and a remote access server for employees to dial into, or it 

can be as complex as hundreds of branch offices globally linked. Special muting protocols and filters minimize the 

expense of sending data over vast distances.  

Wireless Local Area Networks (WLANS)  

Wireless LANs, or WLANs, use radio frequency (RF) technology to transmit and receive data over the air. This 

minimizes the need for wired connections. WLANs give users mobility as they allow connection to a local area 

network without having to be physically connected by a cable. This freedom means users can access shared 

resources without looking for a place to plug in cables, provided that their terminals are mobile and within the 

designated network coverage area. With mobility, WLANs give flexibility and increased productivity, appealing to 

both entrepreneurs and to home users. WLANs may also enable network administrators to connect devices that may 

be physically difficult to reach with a cable.  

Intranet: A Secure Internet-Like Network for Organizations  

With advancements in browser-based software for the Internet, many private organizations have implemented 

intranets. An intranet is a private network utilizing Internet-type tools, but available only within that organization. 

For large organizations, an intranet provides easy access to corporate information for designated employees.  

Extranet: A Secure Means for Sharing Information with Partners  

While an intranet is used to disseminate confidential information within a corporation, an extranet is commonly 

used by companies to share data in a secure fashion with their business partners. Internet-type tools are used by 

content providers to update the extranet. Encryption and user authentication means are provided to protect the 

information, and to ensure that designated people with the proper access privileges are allowed to view it.  

HISTORY OF THE INTERNET  
More than just a technology, the Internet has become a way of life for many people, and it has spurred a 

revolution of sorts for both public and private sharing of information. The most popular source of information 

about almost anything is on the Internet as used daily by technical and non-technical users alike. With the 

meteoric rise in demand for connectivity, the Internet has become a major communications highway for millions 

of users. It is a decentralized system of linked networks that are worldwide in scope.  

The development of computers and advances in the ability to link up several computer units within the same vicinity 

called the Local Area Network (LAN) and in remote locations called Wide Area Network (WAN) prepared the 

ground for the emergence of this powerful and awesome phenomenon which is known as Internet (INTERnational 

NETwork). The internet is a global network of computers linked together by telephone lines, microwave and 

satellite links to form a large single information pool. It is the most advanced, sophisticated and fastest growing 

information system available today.  

The internet was as a result of some visionary thinking by people in the early 1960s who saw great potential value 

in allowing computers to share information on research and development in scientific and military fields. J.C.R. 

Licklider of MIT, first proposed a global network of computers in 1962, and moved over to the Defense Advanced 

Research Projects Agency (DAPGA) in late 1962 to head the work to develop it. Leonard Kleinrock of MIT and 

later UCLA developed the theory of packet switching, which was to form the basis of internet connections. 

Lawrence Roberts of MIT connected a Massachusetts computer with a California computer in 1965 over dial-up 

telephone lines. It showed the feasibility of wide area networking, but also showed that the telephone line s circuit 

switching was inadequate. Kleinrock s packet switching theory was confirmed. Roberts moved over to DARPA in 

1966 and developed his plan for ARPANET.  
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The internet, then known as ARPANET, was brought online in 1969 under a contract led by the renamed Advanced 

Research Projects Agency (ARPA) which initially connected four major computers at universities in the 

Southwestern US (UCLA, Stanford Research Institute, UCSB, and the university of Utah). The contract was carried 

out by BBN of Cambridge, MA under Bob Kahn and went online in December, 1969.  

In the 1970s, Arpanet grew, but in 1984, the National Science Foundation (NSF) of the US government built its 

own network research called the NSF net. Other US government agencies such as NASA followed and got their 

own networks. As the network grew, different internet domains were generated and standardized. They are com for 

commercial institutions, edu for education, gov for government, mil for military, net for network operations and 

services, org for nonprofit organizations while some are used for countries like za for South Africa ca for Canada, 

ng for Nigeria, fr for France, sa for Saudi Arabia and uk for United Kingdom, etc.   

In 1993 the National Science Foundation, who had been running the network pulled out and the Net became open 

to anyone, anywhere.   

Why the Internet?   

The Internet is a fast, easy way to communicate. An email message can be sent anywhere in the world to any number 

of people and can arrive within minutes. Documents, pictures, sounds and video clips can be sent to anyone with 

internet access anywhere in the world. Software such as shareware packages, demos of commercial packages and 

games can be accessed. An enormous range of knowledge and data useful for research can be searched for and 

shared. Other advantages include News group (group on the internet that share news with one another about matters 

that interest individuals which range from commercial, business, sports, medical, etc.), Internet teleconference 

(people on the net that conduct real life discussion by typing your own contribution that others can read and reply), 

online training and learning (e.g. GRE, TOEFL, etc.), e-registration (e.g. WASSCE, NECO, JAMB, NYSC, etc.) 

and e-commerce/business.  

Protocols (Rules of Networking)  

Information is shared on the Internet by means of protocols. Protocols are rules that are followed by computers as 

standards of communications that allow them understand each other. Transferring data in the form of files is one of 

the most common uses of the internet. File Transfer Protocol (FTP) is one of the most popular method used for file 

transfer through the internet. The reason for its popularity is that it has the capability to transfer files between 

different types of computer. Computers that store information that can be transferred via FTP are called FTP servers. 

Those that store information that can be accessed by anybody are called anonymous servers. Some require a specific 

user name and password to login.  

Table 3: Protocols  

Acronym  Full Name  Purpose  

FTP  File Transfer Protocol   For transferring files    

SMTP  Simple Mail Transfer Protocol   For sending email   

POP,IMAP  Post Office Protocol, Interactive Mail Access Protocol   For accessing email   

MIME  Multipurpose Internet Mail Extensions   For  enhancing  email- 

especially for attachments   

HTTP  HyperText Transfer Protocol   Used to transfer web pages   
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The World Wide Web   

Developed by CERN in Geneva in 1990, the World Wide Web (www), also known as the web changed the face of 

the Internet to the extent that people mistakenly think the terms Internet and Web are synonymous. This hypertext 

system allows text, sound, video and pictures to be put on one page of information. These pages can, and often do, 

contain links to other pages whose source can be located anywhere in the world. The Web has made the internet 

much more user friendly and, as such infinitely more popular. It has brought about a time when anyone with the 

necessary resources can gain better access to information (to use the web to locate, read and download document 

stored on computer systems around the world). The Web is cross-platform, i.e. the same information can be viewed 

regardless of the type of computer you use. On the web however, the document are presented as a series of pages 

commonly known as web pages that are linked together to form a web site.  

A web browser, such as Netscape, has the ability to enable access to many different forms of Internet distribution: 

FTP, the Web, Newsgroup and mail all through one application.   

Web Server Addresses   

Web pages that are accessible to all on the Internet are stored on special computers called as web server. Each web 

server is assigned a unique address e.g. www.state.gov.ng. Typically web addresses start with www. The name of 

the site is the name of the organization or person whose pages we are trying to access while type of site is a two or 

three characters code indicating the nature of work.   

Domain Names   

A Domain Name is the name by which an individual or organization chooses to be known on the Internet. It is 

needed for email addresses and for the names of servers connected to the Internet. Once registered it is recognized 

throughout the world and cannot be used by anyone else. The uniqueness of a domain name is crucial to the working 

of the Internet because it ensures that email names and web addresses can t be duplicated. See the following table 

to see how domain names are used:     

Table 4: Domain Names  

Name Type  Example  

Domain name   City.ac.uk  

Personal name   Bilbo Baggins   

User ID  Ab123  

Email   Ab123@city.ac.uk or b.baggins@city.ac.uk  

Website server   www.city.ac.uk  

Personal web space  http://www.student.city.ac.uk/~ab123   

Unix CPU Server   Swindon.city.ac.uk   

Email Clients There are special mail programs available to compose, receive and send mail. They are referred to 

as email client as they reside on the user s computer and are used to communicate with the email server. Email 

client also offer other facilities like maintaining an address book of email addresses that make emailing very simple. 

Examples are Outlook express, Eudora etc.   

http://www.state.gov.ng/
http://www.state.gov.ng/
http://www.city.ac.uk/
http://www.city.ac.uk/
http://www.student.city.ac.uk/~ab123
http://www.student.city.ac.uk/~ab123
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Electronic Mail (E-mail)  

This is a popular resource on the Internet for sending and receiving information. It represents a large portion of all 

Internet traffic and is for many the only Internet resource they use. It can be use for business and personal 

correspondence and exchange of information. Just like normal mail, addresses are required for the exchange of 

email. Everyday person who wishes to use or receive email must have an email address. When a user applied for 

an email address, an account referred to as his email address is created for him on the email server. All email 

addressed to him is received into this account. Email accounts are password protected, thus preventing other users 

from accessing the mail. There are various companies or web sites that provide free email addresses that you can 

use at your convenience and that allow you to access your messages from any computer connected to the internet. 

Some of these companies are Yahoo, Netscape, Hotmail, Google, etc.  

The email address is of this format username@domainname.com: The username is the identity of the user whose 

account it is. The symbol @ separates the Username and the domain name. The domain name is the unique name 

given to the email server e.g. pacific.com. Domain name have two components. Thus pacific is the name of the 

Organization while com is the type of organization (e.g. net, org, etc.). this is also referred to as the Uniform 

Resource Location (URL)  

News Group   

Newsgroup allow for group discussion on specific topic. Some newsgroup focus on buying and selling, health, 

stamp collection, romance, politics etc. There are thousand of newsgroups, once a user gained access to newsgroup 

site there is no cost to subscribe to them. For example imagine that someone has joined a newsgroup involved in 

stamp collecting, as new message about this hobby are sent by other subscribing to his group the message become 

available to the newcomers. This person review not only what someone has sent to the newsgroup but also what 

others have written in response.   

File Sharing and Topic Searching   

One of the original Internet goal was global information sharing. File could be transfer between internet users 

located at different part of the globe within minutes. Search sites or search engines (e.g. yahoo, msn, ask, googles, 

etc.) can be used to locate resources on the internet. The user simply supplies a word or a phrase, the site then 

replies with a list of internet locations where the information can be found. Generally, the search is free and only 

takes a few seconds.  

Browsers  

A browser is a computer application that "understands" the languages (called protocols) of the internet used to 

view web pages. Examples include Internet Explorer, Netscape Navigator, Mosaic, e.t.c. Browsers that only show 

textual information are called Text Based Browsers e.g. Lynx, Alynx, edbrowse (Line-mode browser), ELinks, 

Emacs/W3, Net-Tamer, w3m, and WebbIE.  They make it easy to pick and follow links by selecting  

appropriate highlighted text. Graphical web browsers allow the user to just point and click to access information. 

They have the capability to support hypermedia i.e. sounds, movies, formatted text, and graphics. The most 

popular of graphical browsers are Netscape Navigator, Internet Explorer, and Mosaic.  

A browser is a window object made of five main sections: Title Bar, Menu bar, Toolbar, Address bar, and the 

viewing area.   

   

This is a table of personal computer web browsers by year of release of major version, in chronological order.  

Year  Web Browsers  
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  Pre-browser: HyperCard, Gopher  

1991  Worldwide Web  

1992  ViolaWWW, Erwise, MidasWWW, MacWWW  

1993  Mosaic, Cello, Lynx 2.0, Arena, AMosaic 1.0  

1994  IBM Web Explorer, Netscape Navigator, SlipKnot 1.0, MacWeb, IBrowse, Argo, Minuet  

1995  Internet Explorer, Netscape Navigator 2.0, OmniWeb, WebRouser, Internet Explorer 2, Grail  

1996  
Arachne 1.0, Internet Explorer 3.0, Netscape Navigator 3.0, Opera 2.0, PowerBrowser 1.5, Cyberdog, 

Amaya 0.9, AWeb, Voyager  

1997  Internet Explorer 4.0, Netscape Navigator 4.0, Netscape Communicator 4.0, Opera 3.0  

1998  Internet Explorer 5.0 Beta 1, iCab, Mozilla, Opera 4  

1999  Amaya 2.0, Mozilla M3, Internet Explorer 5.0  

2000  Konqueror, Netscape 6, Opera 4, Opera 5, K-Meleon 0.2  

2001  Internet Explorer 6, Galeon 1.0, Opera 6  

2002  Netscape 7, Mozilla 1.0, Phoenix 0.1, Links 2.0  

2003  Opera 7, Safari 1.0, Epiphany 1.0  

2004  Firefox 1.0, Netscape Browser, OmniWeb 5.0  

2005  
Safari 2.0, Netscape Browser 8.0, Opera 8, Epiphany1.8, Amaya 9.0, AOL Explorer1.0, Maxthon  

1.0, Shiira 1.0  

2006  
SeaMonkey 1.0, K-Meleon 1.0, Galeon 2.0, Camino 1.0, Firefox 2.0, Avant 11, iCab 3, Opera 9, 

Internet Explorer 7, Sputnik  

2007  Maxthon 2.0, Netscape Navigator 9, NetSurf 1.0, Flock 1.0, Safari 3.0, Conkeror  
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2008  Konqueror 4, Safari 3.1, Opera 9.5, Firefox 3, Amaya 10, Flock 2, Google Chrome 1  

RC  Internet Explorer 8  

Beta  Safari 4, Camino 2  

Alpha  Opera 10, SeaMonkey 2, Google Chrome 2  

Web Site/Web Page  

A web page is an area of text and other fancy visual effects that you see when you get on the internet (actually it is 

a file but we haven't learned yet what a file is). A web site is a group of web pages that belong to one section of the 

internet, such as one person, one company, one school, or one government agency, etc (a web site is similar to a 

folder or directory but we haven't learned what a folder or directory are).  

When you get on the internet, you actually access one or different web pages from one or different web sites. To 

access a web page, you must first get to the web site to which the web page belongs and you must know the name 

of the web page. The combination of a web page and the web site it belongs to is called its address. To get the 

address of a web page, you have four main options:   

• If you know the web site that published the web page, you must first go to that web site. To do this, after 

opening the browser, in the address box, you can type the (complete) address of the page   

• If you have already been to that web page before, you may have book marked it. In this case, you can  

"recall" the web page using the main menu of the browser or a button on the browser   

• If somebody sent you the address, on the document (such as an email) that was sent to you, you may just 

click the address that was sent to you (called a link) and the browser would automatically open the web 

page   

• If you are already on the internet and perform a search, the page that allowed you to do the search will 

present you with the address (called a link) of the page. You can just click it and you would be taken to 

that web page   

A Link  

A link is a word or a sentence that, when clicked, would lead you to a web page or produces an internet-related 

action. Because a link is meant for the internet, it is usually displayed in a different color although this depends on 

the person who created the link. There are two main ways you get a link:  

• Somebody may send it to you as a reference or an indication   

• If you are already on the internet, you may see some words or sentences that coincidentally all display in 

the same color   

The color of the link is not really what makes it a link. It is the result of what it produces that makes it a link. To 

distinguish a link from the other text on a document or a web page, when you position your mouse on it, the mouse 

pointer usually changes into a closed hand with a pointing finger. A link can also be created on a picture. To indicate 

that a picture holds a link, when you position your mouse on it, the pointing finger cursor appears.  
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Search Engines   

Although the internet is highly rich with information, that information is not always organized the way you 

particularly expect. When "browsing", you may find it hard to get the particular information you want. To provide 

an alternative, there are some specialized sites that can perform the search for you, with more or less accuracy. 

These sites are referred to as search engines. Some of the most popular of them are Google.com, Yahoo.com, 

Alexa.com, MSN.com, Netscape.com, Altavista.com, and Search.com.   

To do a search, first access a search engine site. Each one of them provides you with a convenient box in which 

you can type the word or sentence to search and press Enter. After a few seconds, the results would be displayed in 

a list. You can then click each link and check it. Most of the search engine sites provide more services than searching 

the web. For example, both Yahoo and MSN provide free email addresses and the ability to check your email 

messages. Some of them also allow you to look for a job, a relationship. Most of them allow you to shop. Many of 

them also provide news, etc.  

Even though the internet simplifies accessing information, its vastness makes it a little difficult to find relevant 

information quickly. To make searching easier, search engines were developed. They are software on the web that 

help internet users to look for specific information. Search engines usually refer to websites that are used to search 

for data on the web. They search for information on the web on the basis of certain keywords specified by the user. 

The result of the search is a list of documents that contain the keywords. However, the list of found documents 

could be long, to narrow down the search; there are several options that can be applied. E.g. putting the phrase in 

quote, the plus and the minus sign.   

Use the plus sign when you want to find articles that contain all of the words you enter. Example, to find article on 

rock and roll music, just type rock + roll + music. Use the minus sign to limit your results to articles with only the 

words you want. Example, if you want articles about pets, but you are not interested in dogs, just type pets-dogs. 

Do not leave any space between the signs (+, -) and the word you want to leave out.   

Phrase it: Search for ideas and concepts instead of just word, using more than one word in your search. To find 

complete phrase, just put quotes around the words that you want to find together. For example, to find information 

on the small scale Business, type Small Scale Business (in quotes). Using quotes tells the search engines to look 

for that exact phrase.           

  Downloading  

 Downloading is the ability to get something from the internet and put it in your computer. By default, downloading 

means that you decide when to get that thing. Unfortunately, some things get into your computer while using the 

internet. Some of these things don't bother your computer; some others do. This is why you should be restrictive 

with the sites you visit.  

By default, sites of big corporations, government agencies, and schools are less harmful, almost not harmful because 

they are more accountable or more responsible. In fact, most responsible or accountable businesses run sites that 

are not harmful at all (you are extremely unlikely to get a disease, I mean a virus, from the web site of a big 

corporation or a government agency).  

Like everything else in life, the internet was abused and is now the source of some bad behaviors. There is no strict 

list of things you should do or sites you should not visit. So, welcome to this world of the Internet.  

Because of bad behaviors some people and corporations have witnessed on the internet, if you work for some 

corporations or government agencies, or if you are accessing the internet using a public or school's computer, you 

may not be able to just download anything you want, and these decisions are right (if you want to download harmful 
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things, do it at home or using your own computer; create your own bad experience, be your own victim, learn from 

your own mistakes; don't do it on someone else's computer. This means that, if a school, an agency, a business, or 

a corporation prevents you from using the Internet any way you want, it is a valid decision they make and you 

should live with it).  

Many big corporations offer free and safe things you can download (big corporations are more responsible and 

accountable; they can't take the risk of having their name dragged to the mud). For example, if you plan to get into 

programming, you can check offerings from http://www.sun.com/, http://www.borland.com/, or DevC++. I 

didn't cite Microsoft, not because I hate the company (I don't) but because most of its free offerings I can remember 

may be installed in your computer already, such as Internet Explorer, Microsoft Works (which is not really free, it 

is just that if you buy your computer in a store, it may have Microsoft Works already but if you don't have Microsoft 

Works and you nee it, you would have to purchase it) or the .NET Framework (the .NET Framework is not really 

free and it is not a program by itself anyway, it is a library whose job is to complete the operating system; 

fortunately, while doing that, it comes with free programs for programmers, not for casual users).    

Chat or Internet Teleconference  

Chat allows group of people to send messages to one another immediately in real time, once connected with a large 

number of other users form all around the world.  Chat rooms are created in such that feature a particular theme, 

such as romance, politics, fictions, science, movies, sport etc. All the messages typed within a chat room appear 

almost simultaneously on the computer screens of all participants for that chat room.   

A chat room is much like a party of people mingling and talking at the same general time, except that are typing 

short messages instead.  

Telnet  

This is a program that is designed to allow user to log into another computer on the internet as a user on that system. 

With this, a user can log into a server to access information stored on it. However, the only those users that have 

been allowed access by the organization can login to the server. Organizations make use of the telnet to make a part 

of their system available to outsiders.  

DISADVANTAGES OF USING COMPUTER  

The importance of computer cannot be overemphasized but there are lots to it than neglecting its demerits. 

Although, this aspect may be viewed based on where you are located in the world. In fact, the most efficient 

technology that has ever evolved is this information age that is based wholly on computer. Some of the negative 

points people raise about computer include computer fraud, security and privacy, and unemployment.  

TYPING/KEYBOARDING  

Now that you know how to use the mouse, the keyboard, and the Internet, you should learn keyboarding. 

Keyboarding is the ability to type professionally. Although it may appear as a waste of time, it absolutely is not. In 

fact, you should invest in learning it.  

http://www.sun.com/,
http://www.sun.com/,
http://www.borland.com/,
http://www.borland.com/,
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If you are taking a class at an institution, the school may (should) provide equipment to you to learn keyboarding. 

If you are on your own, you can go to a computer store and purchase software that would guide you with 

keyboarding. There are many sites that provide good lessons on keyboarding. On a search engine web site, do a 

search on "keyboarding". Check different sites to see what they offer. Besides, sites change all the time. The features 

to look for are that: the early lessons should show you how to position your fingers, the early lessons should start 

on the middle characters, for QWERTY keyboard, these should be asdf;lkjg and h. Other than that, the whole thing 

is about practicing and, unfortunately, no one else can do it for you.  

USING HELP AND SUPPORT KEYBOARD SHORTCUTS  

If your mouse is unavailable or if you prefer using your keyboard, you can use the following keyboard 

commands to navigate within Help and Support Center.  

Table 5: Help and Support keyboard shortcuts  

Press  To  

ALT+F4  Close Help and Support Center.  

ALT+LEFT ARROW  Move back to the previously viewed topic.  

ALT+RIGHT  

ARROW  
Move forward to the next (previously viewed) topic.  

ALT+SPACEBAR  Display the System window menu.  

ALT+TAB  Switch between the open windows.  

CTRL+A  Select all text in a pane.  

CTRL+END  Move to the end of a topic.  

CTRL+HOME  Move to the beginning of a topic.  

CTRL+P  Print a topic.  

CTRL+SHIFT+TAB  Switch to the previous pane.  

CTRL+TAB   Switch to the next pane.  

DOWN ARROW  
 Move down one item in the Index, search results, or list of Help topics.  

F6   Switch focus between the different panes in Help and Support Center.  
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PAGE DOWN  
 Move down one page in the Index, search results, or list of Help topics.  

PAGE UP   Move up one page in the Index, search results, or list of Help topics.  

SHIFT+F10   Display the Help and Support shortcut menu.  

UP ARROW   Move up one item in the Index, search results, or list of Help topics.  

UP  ARROW  

DOWN ARROW  

or   

Scroll through a topic.  

Table 6: Index keyboard shortcuts   

Press  To  

ALT+D or ENTER  Display the associated topic.  

TAB  Place the cursor in the list of keywords.  

TAB to Index, and then press ENTER  Display the Index.  

UP ARROW or DOWN ARROW  Select a keyword in the list.  

Table 7: Search keyboard shortcuts  

Press  To  

ALT+S  Start a search.  

ENTER  Display the selected search result. 

TAB or SHIFT+TAB  Select a search result in the list.  

Table 8: General keyboard shortcuts  

Press  To  

ALT+ Enter  Displays the properties of the selected object.  

ALT+ Underlined letter in a menu name    

Display the corresponding menu.  

ALT+ENTER  View properties for the selected item.  

ALT+ESC  Cycle through items in the order they were opened.  

ALT+F4  Close the active item, or quit the active program.  

ALT+PRINT SCREEN  To make a copy of the active window  

ALT+SPACEBAR  Opens the shortcut menu for the active window.  

ALT+SPACEBAR  Display the System menu for the active window.  

ALT+TAB  Switch between open items.  

BACKSPACE  
View the folder one level up in My Computer or Windows 

Explorer.  

CTRL while dragging an item  Copy selected item.  

CTRL+A  Select all.  

CTRL+C  Copy.  

CTRL+DOWN ARROW  
Move the insertion point to the beginning of the next 

paragraph.  

CTRL+ESC  Display the Start menu.  
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CTRL+F4  
Close the active document in programs that allow you to have 

multiple documents open simultaneously.  

CTRL+LEFT ARROW  
Move the insertion point to the beginning of the previous 

word.  

CTRL+RIGHT ARROW  Move the insertion point to the beginning of the next word.  

CTRL+SHIFT while dragging an item  Create shortcut to selected item.  

CTRL+SHIFT with any of the arrow 

keys  

  

Highlight a block of text.  

CTRL+UP ARROW  
Move the insertion point to the beginning of the previous 

paragraph.  

CTRL+V  Paste.  

CTRL+X  Cut.  

CTRL+Z  Undo.  

DELETE  Delete.  

ESC  Cancel the current task.  

F10  Activate the menu bar in the active program.  

F2  Rename selected item.  

F3  Search for a file or folder.  

F4  
Display the Address bar list in My Computer or Windows 

Explorer.  

F5  Refresh the active window.  

F6  
Cycle through screen elements in a window or on the desktop.  

LEFT ARROW  Open the next menu to the left, or close a submenu.  

PRINT SCREEN  To copy the entire screen as it appears on your monitor  

RIGHT ARROW  Open the next menu to the right, or open a submenu.  

SHIFT when you insert a CD into the 

CD-ROM drive  

  

Prevent the CD from automatically playing.  

SHIFT with any of the arrow keys  
Select more than one item in a window or on the desktop, or 

select text within a document.  

SHIFT+DELETE  
Delete selected item permanently without placing the item in 

the Recycle Bin.  

SHIFT+F10  Display the shortcut menu for the selected item.  

Underlined letter in a command name on 

an open menu  
  

Carry out the corresponding command.  
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ALT + CTRL + DOWN [OR UP, 

LEFT OR RIGHT] ARROW  

 Changes the orientation of the wall paper to the selected 

direction  

Table 9: Dialog box keyboard shortcuts  

Press  To  

ALT+ Underlined letter  Carry out the corresponding command or select the corresponding option.  

Arrow keys  Select a button if the active option is a group of option buttons.  

BACKSPACE  
Open a folder one level up if a folder is selected in the Save As or Open 

dialog box.  

CTRL+SHIFT+TAB  Move backward through tabs.  

CTRL+TAB  Move forward through tabs.  

ENTER  Carry out the command for the active option or button.  

F1  Display Help.  

F4  Display the items in the active list.  

SHIFT+TAB  Move backward through options.  

SPACEBAR  Select or clear the check box if the active option is a check box.  

TAB  Move forward through options.  

You can use the following keyboard shortcuts with a Microsoft Natural Keyboard or any other compatible 

keyboard that includes the Windows logo key (WIN) and the Application key (APL).  

Table 10: Natural keyboard shortcuts  

Press  To  

APL  Display the shortcut menu for the selected item.  

CTRL+ WIN+F  Search for computers.  

WIN  Display or hide the Start menu.  

WIN + Shift + M  Restores minimized windows.  

WIN + Tab Key  Circles through the taskbar buttons  

WIN+ L  
Lock your computer if you are connected to a network domain, or switch users if 

you are not connected to a network domain.  

WIN+BREAK  Display the System Properties dialog box.  

WIN+D  Show the desktop.  

WIN+E  Open My Computer.  

WIN+F  Search for a file or folder.  

WIN+F1  Display Windows Help.  

WIN+M  Minimize all windows.  

WIN+R  Open the Run dialog box.  

WIN+U  Open Utility Manager.  

Table 11: Accessibility keyboard shortcuts  

Press  To  
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Left ALT +left SHIFT +NUM LOCK  Switch MouseKeys on and off.  

Left ALT +left SHIFT +PRINT SCREEN  Switch High Contrast on and off.  

NUM LOCK for five seconds  Switch Toggle Keys on and off.  

Right SHIFT for eight seconds  Switch Filter Keys on and off.  

SHIFT five times  Switch Sticky Keys on and off.  

Table 12: Windows Explorer keyboard shortcuts  

Press  To  

END  Display the bottom of the active window.  

HOME  Display the top of the active window.  

LEFT ARROW  
Collapse current selection if it s expanded, or select 

parent folder.  

NUM LOCK+ASTERISK on numeric keypad (*)  Display all subfolders under the selected folder.  

NUM LOCK+MINUS SIGN on numeric keypad 

(-)  

  

Collapse the selected folder.  

NUM LOCK+PLUS SIGN on numeric keypad (+)  Display the contents of the selected folder.  

RIGHT ARROW  
Display current selection if it s collapsed, or select 

first subfolder.  

If you choose not to apply Windows key combinations to your Remote Desktop sessions, you can use these 

Terminal Server shortcut keys to perform many of the same functions.  

Table 13: Terminal Server Keyboard shortcut  

Shortcut key  Description  

ALT+DELETE  Displays the Windows menu.   

ALT+HOME  Displays the Start menu.  

ALT+INSERT  
Cycles through the programs in the order they were 

started.  

ALT+PAGE DOWN  Switches between programs from right to left.  

ALT+PAGE UP  Switches between programs from left to right.  

CTRL+ALT + END  Brings up the Windows Security dialog box.  

CTRL+ALT+  Minus  (-) 

symbol on the numeric keypad  

Places a snapshot of the active window, within the client,  

on the Terminal server clipboard (provides the same 

functionality as pressing Print-Screen on a local computer.)   

CTRL+ALT+ Plus (+) symbol 

on the numeric keypad  

Places a snapshot of the entire client window area on the  

 Terminal server clipboard (provides the same functionality 

as pressing ALT+ Print-Screen on a local computer.)   

CTRL+ALT+BREAK  Switches the client between a window and full screen.  

FILE PROCESSING  

We have learnt some few things about computing to include the basic knowledge and typing. At this point, any 

work done need to be preserved for future reference. Hence, either when we closed the application or shut down 
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the computer, all our valuable work will be gone. Most of the time, after creating something using an application, 

you may want to keep it for later reference. You may even want to give or send it to someone else. File processing 

consists of creating something on a computer and keeping it. The thing you keep is called information or datum. 

The plural of datum is data. In some cases, the word data can be used in both singular and plural forms. There are 

various issues related and different techniques used to keep data.   

A medium is an object used to hold information in a computer. The plural of medium is media. There are various 

kinds of them.  

1. Internal Hard Drives  

The primary object used to hold information in a computer is called the hard drive:  

  

Figure 10: A Typical Hard Drive  

Everything (data) in your computer is stored in the hard drive. The hard drive is a rectangular box that contains 

some discs and other parts. The information stored in a hard drive is written on its discs. The information can be 

written to, erased from, copied or moved among discs. Although you will perform these operations, the operating 

system is in charge of deciding how the operations are carried out inside. You will not need to know what is going 

on inside.  

The hard drive is inside of the computer, connected to another wide flat object called the motherboard, using cables. 

This type of hard drive is referred to as internal and this the most classic type.  

When you purchase a computer, it already has a hard drive. Later on, you can either add a second one to your 

computer or replace the hard drive in your computer.  

2. External Hard Drives  

Until recently, the hard drive was traditionally thought of as a piece of hardware inside the computer. For this 

reason, it couldn't be carried away easily: you had to open the computer, disconnect the cables, and then remove 

the hard drive. Even then, some other issues were related (such as the type of cable, etc) so much that people were 

not in the habit of carrying a hard drive from one computer to another. Fortunately, another technology was 

developed to use another type of hard drive that stays outside the computer and it is referred to as external.  

An external hard drive is usually connected to the computer using a cable to a port (USB) outside the computer. 

What makes it valuable is that, by simply disconnecting its cable, an external hard drive can easily be carried from 

one computer to another. And because the external hard drive doesn't have the same particularities of cables (IDE 

vs SATA), it can easily be connected to almost any common computer (PC). The external hard drive is fairly easy 

to install. You primarily connect a (USB) cable from the back of the hard drive to a (USB) port on the computer. 

In most cases, it should be ready to install (Plug n' Play) or it may quickly install the software (driver) it needs to 

function. In some cases, after inserting the cable and turning the device on, a window may come up asking you to 
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install something (a driver), which you would also have received from the manufacturer. Install it and continue to 

use the drive.  

3. Internal CD Drives  

One of the problems with external hard drives is that, sometimes they can be heavy (not too heavy but still). Another 

problem is that, to use them on another computer, you must have the right cable and you must physically connect 

them. The remedy to this is to use an object that holds its information but can be ready by a recognizable drive. A 

CD drive is an object that can be used to store information on a disk called a compact disc (CD). It is also connected 

similar to that of the internal hard drives.  

4. External CD Drives  

We also have another type of CD drive that stays outside the computer called an external CD drive. This type is 

usually connected to the computer through an external port (USB). Here is an example:  

  

Figure 11: An External CD Drive  

Like the internal hard drive, the CD drive uses a round disc to store its data. While the hard drive holds its own 

many discs inside, the CD drive doesn't actually have a disc. You insert the disc when you think it necessary, and 

you can insert only one disc. The CD drive can read regular data but it can also play CD music.  

In early days, the CD drive was used only to read the data on a disc. Most CD drives nowadays are also used to 

write to a disc. They are called CD writers or CD burners. As such, the CD writer can be used to both read from, 

and write to, a disc.  

5. Internal DVD Drives  

As you can expect, the CD has some limitations. For example, it can hold only a specify amount of information and 

it can play only music. To overcome some of its limitations, there is the DVD (Digital Video Disc) drive. This drive 

looks like the CD drive and they have the same dimensions.  

6. External DVD Drives  

There is also an external DVD drive. Like the hard and the CD drives, the external DVD drive connects to the 

computer using a (USB) cable connected to a port on the computer. 7. Flash Drives  
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A flash drive is a small drive that can be used to hold data.  

To use it, you insert its metallic side in a USB port on the computer. Once 

you do, it turns itself on and a window may come up asking you what you 

want to do. In some cases, the drive would need to install something (a 

driver) for it to work.   

Figure 12: The Flash Drive  

8. Memory Cards and Card Readers  

The function of a memory card is similar to that of a flash drive except that the card needs a reader for it to be 

useful. You would buy them separately and insert the memory card into the card reader which is invariably 

connected to the computer via the USB port.  

SIMPLE DISK MANAGEMENT  

When a drive has been installed in the computer or inserted on a port, the operating system must recognize it. 

Once it does, for a computer that runs Microsoft Windows, it assigns a letter to it. In Windows Explorer or My 

Computer, a drive is represented by a letter. Here are examples:  

  

Figure 13: Window Explorer showing the drives on a Computer  

Each letter, in this case A, C, D and E represents a drive. In some cases, a letter may not represent a real drive 

physical drive (it may represent a partition among many partitions on the same hard drive). To distinguish a letter 

of a drive from letters of normal words, the letter of a drive is always followed by a colon ":". In Windows 

Explorer or My Computer, the letter of a drive is also included in parentheses.  

In most cases, you should accept the letters, In some cases, you may need to change them. For example, if you 

insert a flash drive, you hear a sound that the computer has recognized it, but the content of the drive doesn't 

show, or the drive letter is not (automatically) assigned (by the operating system). The problem could be that the 

letter the operating system attempted to assign to the drive is already taken but the operating system didn't attempt 

to assign another letter.  

To manage the letters of the drives, you can open the Computer Management MMC. To do this, you can right-

click My Computer ➔ click Manage ➔ in the left frame, click Disk Management. One of the actions you can 

perform here consists of changing a drive letter. To do this, you can right-click a drive letter in the top-right frame 
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or a section in the lower-right frame ➔ click Change Drive Letter And Paths... This would open a dialog box 

that you can use to change the letter.  

DOCUMENTS  

When you open an application, such as a text editor, it displays an empty area with a blinking caret. In the same 

way, if you open a graphics application or a spreadsheet, it also displays an empty area, waiting for your work. You 

can then start performing the type of assignment that the application is expecting. For a graphics application, you 

can start drawing or loading pictures. For a spreadsheet, you can start entering numbers and performing calculations. 

When you start entering text in a text editor or a word processor, you are said to create, or work on, a document. If 

you start drawing shapes or manipulating pictures in a graphics application, you are said to work on a document. If 

you start entering numbers and performing calculations in a spreadsheet, you are said to work on a document.  

Saving a Document  

After creating a document, you may want to preserve it for later use. Preserving a document is referred to as saving 

it. You have many options and this may depend on the application you are using. In most cases, if an application 

was created using the standards described and recommended by Microsoft, to save the document, on the main menu, 

click File ➔ Save:  

• If the document was never saved before, a dialog box would come to assist you   

• If the document was saved previously, it would be saved behind the scenes and the new version would include 

the new changes   

A document can also be saved when you attempt to close an application:  

• If you create a document or modify one, if you close the application (or the window), you will be asked 

whether you want to save it. If you want to save it, you should click Yes. If the document was not saved 

previously, a dialog box would come up.   

• If you have modified a previously saved document and if you attempt to close the application (or the 

window), the computer would ask you whether you want to save the document. If you want to save it, you 

should click Yes. In this case, the new version of the document would keep the changes you made. If you 

click No, the document would revert back to what it was before it was opened or the previous time it was 

saved   

When saving a document for the first time, you must give it a name and a location.  

To make it possible to easily recognize its information in a computer that runs Microsoft Windows, a drive, such 

as those we have reviewed above, uses some units. The primary unit is called a directory. In Windows Explorer or 

My Computer, a directory is represented by a letter. When (the disc of) a drive is created, it doesn't contain 

directories. This is because the manufacturer doesn't decide how and on what type of computer the drive will be 

used. When a drive is installed on a computer, the operating system decides about the drive, creates it as a directory 

and assign a letter to it. You can store a document on a drive but this is not recommended.  

Creating a Folder  

To better organize the information that it contains, one or more units can be created on a drive. Each unit is called 

a folder. When (the disc of) a drive is created, it doesn't contain folders. When the operating system is installed, it 

creates a few folders. You also can create a folder and you have many alternatives.  
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When it comes to folders, a drive is called the root folder or simply, the root. To create a folder in the root, in 

Windows Explorer or My Computer:  

• In the left frame, click the drive. On the main menu, click File ➔ New ➔ Folder and give it a name   

• In the left frame, click the drive. In the right frame, right-click a white empty area ➔ position the mouse on 

New ➔ click Folder. Then give it a name   

You can also create a folder inside of another. The folder that will contain the new one is referred to as the parent 

folder. The other will be referred to as a child folder. To create a folder in another folder, in Windows Explorer or 

My Computer:  

• In the left frame, expand the drive by clicking its + button. Under the drive, click the folder name. If the new 

folder will be created inside of another folder that itself has a parent, expand it also and click the parent folder. 

On the main menu, click File ➔ New ➔ Folder and give it a name   

• In the left frame, click the drive and click the parent folder. In the right frame, right-click the parent folder, 

position the mouse on New and click Folder, then give it a name   

You can also create a folder when saving a file. To do this, in the dialog box that comes up, click the Create New 

Folder button and give it a name.  

Naming a Folder  

There are some suggestions you should follow and various rules you must observe when naming a folder:  

• The name of a folder can be a single letter or a digit   

• The name of a folder can also be a single special character except the following: | > / : \ < ? * and "  

• The name of a folder can be a combination of letters, digits, and some special characters   

As a suggestion, you should use a name that indicates what is stored in the folder. This makes it easy to find 

information.  

Archive  

Archives are files that contain other files. Typically the files in an archive are compressed. Archives usually have 

file names ending with ZIP, LZH, ARJ, or ARC, depending on how they were created. Archives make it easy to 

group files and make transporting and copying these files faster.  

Typical Uses of Archives  

• Most files available on the Internet and on electronic services like America Online are distributed as archives. 

Two benefits of using archives for electronic file distribution are that only one file transfer operation 

("download") is required to obtain all related files, and file transfer time is minimized because the files in an 

archive are compressed.   

• It is often useful to send a group of related files to an associate. Rather than distributing individual files it is 

often easier to distribute the files as an archive to benefit from the file grouping and compression.   

• Some files are important but not used often. To save disk space simply compress these files into an archive 

when they are not used, and decompress them only when needed.   
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Self-Extracting Zip File  

A self-extracting Zip file is an executable program file (.EXE file) that includes both a Zip file and software to 

extract or "unzip" the contents of the Zip file. Users can extract the contents of a self-extracting Zip file by simply 

running it. This is convenient, because the end user does not need an unzip program (like WinZipfi) to extract 

files from these self-extracting archives.  

WinZip Self-Extractor Personal Edition, included with WinZip, creates Windows self-extracting Zip files.  

Archive formats:  

• Zip files are the most common archive format. Zip files can span multiple disks, and provide both 

compression and file grouping. WinZip does not use external programs to work with Zip files.   

• TAR, Z, GZ, TAZ, and TGZ files are often found on Unix-based Internet sites. TAR stands for "Tape 

ARchive". The TAR format does not provide compression; it is used only to group files. GZ and Z files are 

gzip files. GZ and Z files cannot contain multiple files. TAZ and TGZ files are TAR files compressed in the 

gzip format. Since almost all new archives are created in Zip format, WinZip does not provide facilities to add 

to or create files in these formats (however, all other WinZip functions are supported). WinZip does not use 

external programs when working with files in these formats.   

• File formats such as UUencoded, XXencoded, BinHex, and MIME are used primarily to transfer binary files 

by Internet e-mail. If you encounter one of these files, you can open it and extract its contents with WinZip. 

You can UUencode an archive using the UUencode entry in the WinZip Actions pull-down menu. WinZip 

does not use external programs when working with files in these formats.   

• WinZip also handles most files in the old Microsoft Compress format (also known as LZEXPAND format). 

However, there are several variations on this format, and Microsoft has not released documentation on these 

variations. WinZip issues an appropriate message if you attempt to decompress a file not supported by your 

version of Windows. Microsoft Compress files usually end with a trailing underscore, for example, 

"commdlg.dl_". Like Z and GZ files, Microsoft Compress format files contain only one file. This format is 

used for many files on the Windows 3.1 distribution disks and many older Microsoft products. Note that not 

all files ending with an underscore are Microsoft Compress format files. WinZip does not use external 

programs when working with files in these formats.   

• The Microsoft CAB (short for Cabinet) format is used by most Microsoft setup programs, including those 

used to install Windows. CAB files provide both file compression and file grouping. You can use WinZip to 

open and extract the contents of CAB files. WinZip will handle most self-extracting CAB files. WinZip does 

not use external programs when working with CAB files.   

• ARC, ARJ, and LZH are older formats that provide both grouping and compression, like Zip files. Unlike 

other supported file formats, WinZip's optional support for these formats requires external programs that are 

not included as part of the WinZip distribution.   

Files  

In our introductions, we defined a document as what you create in an application. In a word processor, the characters 

you type constitute a document. For a graphics application, the drawings you perform or the picture you manipulate 

is called a document. In order to keep such a document for later use, you must store it somewhere. A file is an object 

used to hold a document. Put it another way, in order to have a file, you must save a document. We have mentioned 
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how to save a document. Like a folder, you must name a file when saving a document. The name of a file follows 

the same rules we defined for a folder.  

FILE MANAGEMENT  

Bits and Bytes  

To hold information, a medium such as a hard disk uses a system that resembles a combination of small boxes. Let's 

illustrate it as follows:  

  

This box can hold only a small piece of information. It can only be either 0 or 1. When the box is empty, it holds a 

value of 0. When it is full, it holds a value of 1:  

 

0  

1  

You can represent a piece of information with one of two states. This box used to represent a value is called a binary 

digit; in its abbreviated form, it is called a bit (for binary digit).   

  

 0000,  0001,  0010,  0011,  0100  

  

 0101,  0110,  0111,  1000,  1001  

  

  

 1010,  1011,  1100,  1101,  1110  

  

 1111  

This produces the following binary combinations: 0000, 0001, 0010, 0011, 0100, 0101, 0110, 0111, 1000, 1001, 

1010, 1011, 1100, 1101, 1110, 1111 = 16 combinations. When using the decimal system, these combinations can 

be represented as 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, and 15.  

This combination is also a system that the computer uses to count bits internally. This technique is valuable and 

allows you to always identify a number as a divider of 4.  

When all bits of a group of 4 are 0, the combination has the lowest value, which is 0000. Any of the other 

combinations has at least one 0 bit, except for the last one. When all bits are 1, this provides the highest value 

possible for a group of 4 bits. The lowest value, also considered the minimum value, can be represented as 0. The 

highest value, also considered the maximum, can be expressed in decimal value as 24 (2 represents the fact that 

there are two possible states: 0 and 1; 4 represents the fact that there are four possible combinations), which is 16. 

This produces 16 because 24 = 16.  

A combination of 8 consecutive bits is called a byte. The bits are counted from right to left starting at 0:  
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You can represent a byte using a combination of 0s and 1s. If you have the patience to create combinations of bits 

using the boxes as we did for the group of 4, you would find out that there are 256 possible combinations. Another 

way to find it out is by using the base 2 technique:  

27 + 26 + 25 + 24 + 23 + 22 + 21 + 20 = 128 + 64 + 32 + 16 + 8 + 4 + 2 + 1  

= 255  

Therefore, the maximum decimal value you can store in a byte is 255. Remember that the byte with all bits having 

a value of 0 has its value set to 0. Since this byte also holds a valid value, the number of combinations = 255 + 1 = 

256.  

The only type of information you can store in a byte is a character or symbol, such as a readable letter from the 

alphabet: a, b, c, d, e, f, g, h, i, j, k, l, m, n, o, p, q, r, s, t, u, v, w, x, y, z, A, B, C, D, E, F, G, H, I, J, K, L, M, N, O, 

P, Q, R, S, T, U, V, W, X, Y, and Z. Besides these readable characters, a byte can also hold one digit: 0, 1, 2, 3, 4, 

5, 6, 7, 8, 9. A byte can also hold a readable or non-readable symbols such as ` ~ ! @ # $ % ^ & * ( ) - _ =  

+ [ { ] } \ | ; : ' < ? . / , > "  

This means that a combination of 8 bits, called a byte, is enough to represent one symbol recognized in the English 

language. In this globalization word, a computer also needs to be able to store characters from other Latin-based 

languages such as letters from Franais or Espaæol. To make this possible, instead of 8 bits, the operating system 

must use 16 bits. A combination of 16 consecutive bits is also called a word.  

A group of 1000 bytes is supposed to be called a kilobyte but, based on the way the computer calculates the bits, a 

group of 1024 bytes is called a kilobyte or KB. A group of 1,000,000 bytes is called a megabyte but actually it is a 

group of 1,024,000 bytes that is called a megabyte or MB. A group of 1,000,000,000 bytes or actually a group of 

1,073,741,824 bytes is called a gigabyte or GB.  

The Size of a Drive  

Because a drive cannot have unlimited space, it is recognized for its size. The size of a drive can be measured by, 

or specified in, MB or GB. For example, a typical CD can hold 700MB of data. A regular DVD can hold information 

up to 4.7GB in size. The sizes of hard drives are very varied. To find the size of a hard drive in your computer, from 

either Windows Explorer or My Computer, you can right-click the drive letter and click Properties.   

The Size of a File  

In order to keep track of the various files in a computer, each file has a size. The size of a file can be measured in 

bytes, kilobytes, or megabytes. To know the size of a file, in either Windows Explorer or My Computer, you can 

right-click it and click Properties.   
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